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Preface


This document is a formal contract deliverable with an approval code 1. It requires Government

review and approval prior to acceptance and use. This document is under ECS contractor

configuration control. Once this document is approved, contractor-approved changes are handled

in accordance with Class I and Class II change control requirements described in the EOS

Configuration Management Plan. Changes to this document shall be made by Document Change

Notice (DCN) or complete revision.


Any questions or proposed changes should be addressed to:


Data Management Office

The ECS Project Office

Hughes Information Technology Systems

1616 McCormick Drive

Upper Marlboro, Maryland 20774-5372
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Abstract


This document provides the information needed to operate the operations tools for the Earth 
Observing System (EOS) AM-1 Flight Operations Segment (FOS) Maintenance and Operations 
(M&O) portion of the Earth Observing System Data and Information System (EOSDIS) Core 
System (ECS). It is organized so that general information required by most users is contained in 
Sections 3 through 7. Section 8 covers material pertinent to users performing scheduling 
functions. Section 9 details material pertinent to users performing real-time functions. Section 10 
covers material pertinent to users performing off-line functions. 
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1. Introduction 

1.1 Identification 

The Operations Tools Manual for the Earth Observing System (EOS) AM-1 Flight Operations 
Segment (FOS) Maintenance and Operations (M&O) portion of the ECS, Contract Data 
Requirement List (CDRL) item 116, whose requirements are specified in the Data Item Description 
(DID) 609/OP1, is a required deliverable under the Earth Observing System Data and Information 
System (EOSDIS) Core System (ECS), Contract NAS5-60000. 

1.2 Scope 

This document reflects the February 7, 1996, Technical Baseline maintained by the contractor 
Configuration Control Board (CCB) in accordance with ECS Technical Direction No. 11, dated 
December 6, 1994. 

1.3 Purpose 

This document is intended to provide information needed to operate the Operations Tools of the 
FOS. The focus of this document is the full complement of FOS Release B capabilities existing at 
the EOS Operations Center (EOC). The Flight Operations Segment (FOS) Release B Instrument 
Support Terminal (IST) Toolkit Release Notes, for the ECS Project, White Paper, October 1997 
(#343-WP-002-002) and the Flight Operations Segment (FOS) Instrument Support Terminal (IST) 
Toolkit Installation Guide, White Paper, September 1997 provide information tailored for FOS IST 
capabilities and installation. 

The FOS Release A Version Description Document (VDD), Version 1.02.00, 814-RD-007-007, 
March 1997, provides a complete description of the FOS Release A system. 

This document is organized so that general information required by most users is contained in 
Sections 3 through 7. Section 8 covers material pertinent to users performing scheduling 
functions. Section 9 details material pertinent to users performing real-time functions. Section 10 
covers material pertinent to users performing off-line functions. Section 11 covers naterial 
pertinent to users performing command management functions. Section 12 covers file 
management operations. 

1.4 Status and Schedule 

This document provides users with material relevant to FOS capabilities. 
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1.5 Organization


This document is organized as follows: 

a.	 Section 1 provides information regarding the identification, scope, purpose, status, and

organization of this document.


b. Section 2 lists documents used as sources as well as supplemental documents.


c.	 Section 3 provides an overview of the FOS, focusing on high-level operational concepts.

This section summarizes the operations staff’s key activities and includes an overview of

the system in the context of operational activities.


d.	 Section 4 describes the steps required to both initialize and shutdown EOC hardware and

software.


e. Section 5 is an introduction to generic userstation functions.


f.  Section 6 is an introduction to the ECS Command Language (ECL).


g.	 Section 7 focuses on FOS Common Services that all Flight Operations Team

(FOT)/Instrument Operations Team (IOT) personnel will need to perform general FOS

functions (schedulers, real-time operators, or off-line engineers).


h.	 Section 8 focuses on services that both the FOT Mission Planner and IOT personnel need

to perform scheduling functions.


i.	 Section 9 focuses on services that the Flight Operations Controller/Shift Supervisors,

Spacecraft Activity Controller, Spacecraft Evaluator, and Instrument Evaluator will use.


j.	 Section 10 focuses on services that the Flight Operations Controller/Shift Supervisors,

Spacecraft Evaluator, Instrument Evaluator, and Flight Systems Off-line Engineer will use.


k. Section 11 focuses on the Command Management Subsystem.


l. Section 12 explains EOC file management.


m. Appendix A contains a list of ECL directives and their syntax.


n. Appendix B contains FOS event definitions.


o. Appendix C contains ground telemetry mnemonics and their descriptions.


p. Appendix D contains the Carry-Out file description.


q. Appendix E contains symbols that represent orbital events displayed in the Timeline.


r.  The glossary contains key terms included in this document.


s . 	 The alphabetized list of abbreviations and acronyms spells out abbreviations and acronyms

used in the document.
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1.6 Conventions 

The following conventions are employed to differentiate explanatory text from objects displayed on 
the userstation screen or commands: 

a. Items included in a menu are in a bold typeface (i.e., Open, Close Save). 

b.	 Buttons on window displays, which are activated by positioning the mouse pointer over the 
button and pressing (“clicking”) the left mouse button, are bold, Helvetica typeface (i.e., 
OK , Close, Help). 

c.	 ECL commands are Helvetica typeface (i.e., START, CONNECT). Values input by the 
user are Helvetica, italicized typeface (i.e., MIRROR, 100). 

d. Buttons on the computer keyboard are delineated by brackets (i.e., <Enter>). 
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2. Related Documentation 

2.1 Parent Documents 

The parent documents are the documents from which this FOS Operations Tools Manual’s scope 
and content are derived. 

304-CD-001-003	 Flight Operations Segment (FOS) Requirements Specification for the 
ECS Project, Volume 1: General Requirements. 

304-CD-004-003	 Flight Operations Segment (FOS) Requirements Specification for the 
ECS Project, Volume 2: AM-1 Mission Specific. 

307-CD-001-003 Flight Operations Segment (FOS) Release Plan and Development Plan 
329-CD-001-003 for the ECS Project. 

2.2 Applicable Documents 

The following documents are referenced within this FOS Operations Tools Manual, are directly 
applicable, or contain policies or other directive matters that are binding upon the content of this 
document. 

209-CD-002-005	 Interface Control Document Between EOSDIS Core System (ECS) and 
ASTER Ground Data System. 

814-RD-007-005 Version Description Document, Version 1.01.00. 

421-11-19-02	 Goddard Space Flight Center, Spacecraft Simulator/EOS Operations 
Center ICD, October 1996. 

505-10-35	 Goddard Space Flight Center, DFCD for the EOS AM-1 Project 
Database, August 1996. 

505-41-37	 Goddard Space Flight Center, ICD Between ECS and the Version 0 
System for Interoperability, March 1996. 

505-41-38	 Goddard Space Flight Center, ICD Between the ECS and the EOS-AM 
Project for the AM-1 Spacecraft Analysis System for the ECS Project, 
March 1996. 

540-031	 Goddard Space Flight Center, ICD Between the EOSDIS Backbone 
Network and EOC, September 1996. 

510-ICD-EDOS/EGS	 ICD Between EDOS and EOS Ground System (EGS) Elements, August 
1996. 

530-ICD-NCCDS/MOC	 ICD Between the Network Control Center Data System and Mission 
Operations Center, December 1996. 
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552-FDD-96/010R0UD0	 EOS-AM1 Flight Dynamics Division/EOSDIS Core System ICD, 
October 1996. 

2.3 Information Documents 

The following documents are referenced herein and amplify or clarify the information presented in

this document. These documents are not binding on the content of this FOS Operations Tools

Manual.


305-CD-040-002 through Flight Operations Segment (FOS) Release B Design Specification

305-CD-049-002 and for the ECS Project.

305-CD-079-001


360-TP-001-002	 Flight Operations Segment (FOS) COTS Hardware for Release B, 
Technical Paper for the ECS Project. 

604-CD-001-004 Operations Concept for the ECS Project: Part 1 – ECS Overview. 

604-CD-002-003 Operations Concept for the ECS Project: Part 2B – ECS Release B. 

604-CD-003-002 Operations Concept for the ECS Project: Part 2A – ECS Release A. 

605-CD-003-001	 Operations Scenario Document for the ECS Flight Operations 
Segment (FOS). 

607-CD-001-002	 ECS Maintenance and Operations Position Descriptions for the ECS 
Project. 

612-CD-003-001 through Flight Operations Segment (FOS) Release B Programmer’s Manual 
612-CD-013-001 for the ECS Project. 

RTWorks 	 RTdraw User Interface Design; RThci Human-Computer Interface; 
documentation RTie Interface Engine. 

Tivoli documentation TME 10 Framework User’s Guide; Tivoli/Sentry User’s Guide. 

Sybase documentation Transact-SQL User’s Guide. 

Altair documentation	 Technical Reference for Altair Mission Control System Toolkit; Altair 
Mission Control System Training Manual. 
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3. FOS Overview 

The ECS FOS is deployed at the EOS Operations Center (EOC) and the FOS Instrument Support 
Terminal (IST) toolkit. The EOC performs mission planning, commands and controls the U.S. 
EOS spacecraft and instruments, and coordinates mission operations for other non-U.S. EOS 
instruments onboard the U.S. spacecraft. EOC operations support the EOS mission life cycle, 
which includes pre-launch, launch, and on-orbit operations occurring in parallel with operator 
simulations training, as well as interface tests, system tests, and end-to-end tests; supports 
concurrent operations with maintenance, system upgrades, and sustaining engineering activities; 
and simultaneously supports command, control, and analysis of multiple spacecraft and their 
instruments. 

The EOC is located at Goddard Space Flight Center (GSFC) in Greenbelt, Maryland, and is 
operated by the Flight Operations Team (FOT). The FOT is responsible for: maintaining spacecraft 
and instrument health and safety; monitoring spacecraft performance; performing spacecraft 
engineering analysis; performing high-level monitoring of instrument mission performance; and 
providing periodic reports documenting spacecraft and instrument operations. 

Instrument operations are distributed using FOS IST toolkits, which are deployed at instrument 
Principal Investigator/Team Leader (PI/TL) facilities. IST toolkits enable PI/TLs to remotely 
participate in planning, scheduling, monitoring, and analyzing their instruments in conjunction 
with the FOT at the EOC. 

1. FOS External Interfaces 

2. Flight Operations Services 

3. FOT Overview 

4. FOT Interaction with FOS Services 

3.1 FOS External Interfaces 

The FOS context diagram in Figure 3.1-1 shows, at a high level, the relationship between the EOC 
and its external interfaces. This diagram also shows interfaces between the EOC and other ECS­
internal elements [i.e., the ECS Science Data Processing Segment (SDPS) at the GSFC Distributed 
Active Archive Center (DAAC) and ECS System Monitoring and Coordination (SMC)]. 
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Figure 3.1-1.  FOS External Interface Context Diagram



3.1.1 EDOS Interface 

EDOS provides the EOC’s interface with the Space Network (SN) and ground stations for 
spacecraft commanding and telemetry operations. The EOC sends spacecraft uplink data, 
including spacecraft and instrument commands and command loads, to the spacecraft via the EDOS 
interface. EDOS, in turn, provides the EOC with spacecraft command receipt status, as provided 
by the spacecraft. 

EDOS sends real-time spacecraft and instrument housekeeping telemetry to the EOC. This data is 
used by the FOT to monitor spacecraft and instrument health and safety during real-time contacts, 
and to perform command execution verification. 

EDOS also sends spacecraft and instrument housekeeping telemetry to the EOC. The rate-buffered 
service EDOS provides after contact completion. 

Data interface status messages are also sent between the EOC and EDOS and are specified in the 
ICD Between EDOS and EOS Ground System (EGS) Elements. The Real-Time and Offline 
interfaces between EDOS and FOS are illustrated in Figures 3.1.1-1 and 3.1.1-2 respectively. 

FOSEDOS 

Command Data Blocks 

CLCWs 

Command Test Block 

CODAs 

Telemetry 
(H/K, H&S, Diagnostic (Dumps)) 

Command Echo Block 

Figure 3.1.1-1. Real-Time Interface between EDOS and FOS 

FOSEDOS 
Rate Buffered File (Telemetry) 

SN Schedules 

Trash Buffer File 

SCS Summary Report 

Figure 3.1.1-2. Offline Interface between EDOS and FOS 
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3.1.2 NCC Interface 

The EOC submits Tracking and Data Relay Satellite System (TDRSS) schedule requests and non­
telemetry messages (e.g., link reconfiguration requests) to the Network Control Center (NCC). 
In response, NCC sends TDRSS schedules notifying the EOC of the status of its request and non­
telemetry messages (e.g., TDRSS link status messages, performance data). 

Data interfaces between NCC and EOC are specified in the Interface Control Document (ICD) 
Between the NCC Data System and Mission Operations Centers. Real-time interfaces between the 
NCC and FOS are illustrated in Figure 3.1.2-1; Planning and Scheduling interfaces with the NCC 
are illustrated in Figure 3.1.2-2. 

FOS NCC 

GCMR Msgs. 

GCM Disposition Msg. 

GCM Status Msg. 

UPD Msgs. 

Acq. Failure Notification Msg. 

Time Transfer Msg. 

Communication Test Msg. 

Comm. Test Msg. (echo) 

Figure 3.1.2-1. Real-Time Interface between NCC and FOS 

FOSNCC 

Schedule Add Request 
Schedule Delete Request 

Schedule Result Msg. 

User Schedule Msg. 

User Schedule Msgs. 

Schedule Deletion Notification 

Figure 3.1.2-2. FOS Planning and Scheduling Interface with NCC 
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3.1.3 FDD Interface 

The FDD sends both predicted orbit data and spacecraft contact view period information, and 
planning aids to EOC for use in spacecraft and instrument planning and scheduling. FDD also 
develops plans for spacecraft maneuvers in conjunction with EOC and sends spacecraft maneuver 
parameters to EOC. The FOT schedules and implements these plans. FDD sends FDD parameters 
needed for spacecraft onboard table generation to the EOC. 

EOC provides selected attitude and navigation data parameters to FDD for analysis. This data is a 
subset of spacecraft housekeeping telemetry nominally captured by EOC during a real-time contact. 
In addition, back-orbit telemetry subsets may also be sent to FDD from EOC in the form of 
standard analysis carry-out files. 

Data interfaces between FDD and EOC for the AM-1 Mission are specified in the EOS-AM1 
FDD/ECS ICD. Table 3.1.3-1 lists FDD products, their filenames, the ICD section that discusses 
the product’s format as well as the end use of the product in FOS. Figure 3.1.3-1 provides an 
overview of the FDD management process. 

Table 3.1.3-1. FDF Products 
FDF PRODUCT FILENAME ICD 

SECT 
Dataset Statistics PAS FTP 

ASTER 
Table 
Load 

Archived 

FSS Transformation Table FSSTRANS 3.3.3.1 X X 

FSS Calibration Table FSSCALIB 3.3.3.2 X X 

SSST Transformation Table SSSTTRANS 3.3.3.3 X X 

SSST Parameters Table SSSTPARAM 3.3.3.4 X X 

IRU Transformation Table IRUTRANS 3.3.3.5 X X 

IRU Scaling Table IRUSCAL 3.3.3.6 X X 

Attitude Slew Table ATTSLEW 3.4 X X 

EOS Mission Star Catalog STARCATALOG 3.5 X X 

Star Density Profile STAR1DENPROF 
STAR2DENPROF 

3.6 X X 

SSST Star Interference STAR1INTERFER 
STAR2INTERFER 

3.7 X X 

ESA Sun/Moon Interference ESAINTERFER 3.8 X X 

FSS Visibility Predict FSSVISPREDICT 3.9 X X 

TDRS State Vectors TDRS1STATE 
TDRS2STATE 
TDRS3STATE 
TDRS4STATE 

3.11 X X X 

EOS Brouwer-Lynddane 
Elements 

EOSBLELEM 3.12 X X X X 

TDRS Brouwer-Lynddane 
Elements 

TDRS1BLELEM 
TDRS2BLELEM 
TDRS3BLELEM 
TDRS4BLELEM 

3.13 X X 

Simulated EOS-AM1 
Spacecraft Ephemeris 

SIMSCEPHM 3.15 X 

Filter Tuning Parameters TUNINGPARAM 3.16 X X X 

OMNI-to-TDRS Viewing 
Times 

OMNITDRS 3.17 X X X 

HGA-to-TDRS Viewing 
Times 

HGATDRS 3.18 X X X 

OMNI-to-Ground Station 
Viewing Times 

OMNIGRND 3.19 X X X 
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Table 3.1.3-1. FDF Products (continued) 
FDF PRODUCT FILENAME ICD 

SECT 
Data-set Statistics PAS FTP 

ASTER 
Table 
Load 

Arch�
ived 

HGA Gimbal Angles HGAGIMBAL 3.20 X X X 

Predicted EOS-AM1 
Ephemeris 

EOSEPHM 3.21 X X X X 

Predicted TDRS Ephemeris TDRS1EPHM 
TDRS2EPHM 
TDRS3EPHM 
TDRS4EPHM 

3.22 X X X 

Orbit Adjust Maneuver 
Request 

ORBITMANREQ 3.24 X 

Delta-V Parameters Table DELTAVPARM 3.25 X X 

Mass and Center of Mass 
Location Estimates 

MASSLOCATION 3.26 X X X X 

Predicted EOS-AM1 
Ranging Data File 

FDFRANGE 3.27 X 

Attitude Predictions ATTITUDE 3.28 X X 

Predicted Orbital Events ORBEVENT 3.29 X X X 

Planned Orbit Maneuver 
Dataset 

MNVRTIME 3.30 X X X 

Solar/Lunar Azimuth and 
Elevation Angle 

CERSUNAZEL 
MISSUNAZEL 
MOPSUNAZEL 
MODSUNAZEL 
CERMOONAZEL 
MISMOONAZEL 
MOPMOONAZEL 
MODMOONAZEL 

3.31 X X 

Solar Beta Angles SOLBETA 3.32 X X 

Predicted Local Sun Time LOCALSUN 3.33 X 

Lunar Beta Angles LUNBETA 3.34 X 

MODIS/MISR Sun and Moon 
FOV Events 

SUNMNFOVEVNT 3.35 X X 

MODIS/MISR Planets/Stars 
FOV Events 

PLSTFOVEVNT 3.36 X X 

Predicted Sub-Satellite Point 
(Groundtrack) 

GRNDTRCK 3.37 X X 

Predicted Spacecraft Altitude ALTITUDE 3.38 X 

Predicted Spacecraft 
Day/Night Length 

DAYNIGHT 3.39 X X 

AM-1 State Error 
Covariance Matrix 

STATEERRCOV 3.40 X X 

Solar/Lunar /Planetary (SLP) 
Ephemerides 

SLPEPHM 3.41 X 

Ku-Band Oscillator 
Frequency Report 

OSCFREQREP 3.48 X X X 

X-band Interference Times XBANDDSN 3.50 X X 

Apogee/Perigee Altitude File PERAPALT 3.51 X X 

Predicted Orbit Number and 
Start Times 

ORBITNUM 3.53 X X 

UTC to UT1 Timing 
Difference 

TIMINGDIFF 3.54 X X 

Predicted Instrument Orbit 
Events 

INSTORBEVENT 3.55 X X 
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Table 3.1.3-1. FDF Products (continued) 
FDF PRODUCT FILENAME ICD 

SECT 
Data-set Statistics PAS FTP 

ASTER 
Table 
Load 

Arch�
ived 

Predicted EOS AM-1 State 
Vector 

EOSSTATEVECT 3.56 X X 

Simulated TDRS State 
Vectors 

SIMTDRS1STAVEC 
SIMTDRS2STAVEC 
SIMTDRS3STAVEC 
SIMTDRS4STAVEC 

3.57 X 

Simulated EOS AM-1 
Brouwer-Lynddane Elements 

SIMEOSBLELEM 3.58 X 

Simulated TDRS Brouwer-
Lynddane Elements 

SIMTDRS1BLELEM 
SIMTDRS2BLELEM 
SIMTDRS3BLELEM 
SIMTDRS4BLELEM 

3.59 X 

Simulated EOS AM-1 State 
Vectors 

SIMSTAVEC 3.60 X 

X-Band Ground Station 
Contact Times 

GRNDCONTACT 3.61 X X 

MODIS FOV Target View 
Period 

MODISFOV 3.62 X X 

Earth Gravity Model 
Spherical Harmonic 
Coefficient 

HARMONICCOEFF 3.63 X X 

Earth Gravity Model Degree 
Variance 

DEGREEVAR 3.64 X X 

Harris-Priester Atm. Density 
Model Data 

MAXDENSMODEL 
MINDENSMODEL 

3.65 X X 

Solar Ephemeris 
Modification Data 

SOLEPHMMOD 3.66 X X 

EOS AM-1 Modeling Data EOSMODELING 3.67 X 

TDRS Modeling Data TDRSMODELING 3.68 X X 

Ground Antenna Modeling 
Data 

GRNDANT1MODEL 
GRNDANT2MODEL 
GRNDANT3MODEL 
GRNDANT4MODEL 

3.69 X X 

State Tolerance Data STATETOLER 3.70 X X 

Doppler Measurement 
Tolerance Data 

MEASTOLER 3.71 X X 

Covariance Tolerance Data COVTOLER 3.72 X X 

Navigation Time Step Data NAVTIMESTEP 3.73 X X 

Phys. and Math. Constants PHYSCONST 3.74 X X 

Master Oscillator Frequency 
Bias Data 

FREQBIAS 3.76 X X 

Atmospheric Drag Data ATMOSDRAG 3.77 X X 

TDRS Measurement Bias 
Data 

TDRSMEASBIAS 3.78 X X 

Simulated UTC to UT1 
Timing Difference 

SIMTIMINGDIFF 3.79 X 

Navigation Thruster Table NAVTHRUSTER 3.80 X X 
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FDD 
FTP products 

ISTs 

-Receive requested FDD 
products 

DMS 
-Validate and ingest FDD 
products into Ops Database 

ANA 
-Generate and store statistics 
- Generate datasets 

PAS 
-Place orbital events on timeline 
-Create instrument-unique 
events (Event Generator tool) 

GSFC DAAC 
-Archive all FDD files 
-Archived files are purged 
from ops database 

CMS 

-Generate FDF table loadsFDD Table 
Load files 

Figure 3.1.3-1. FDD Management Process 

The FOS receives, ingests and processes a variety of FDD products. Figures 3.1.3-2 through 
3.1.3-6 illustrate the interfaces and products transferred between FDD and FOS. Refer to the 
EOS-AM1 FDD/ECS ICD for additional information. 

The Data Management Subsystem (DMS) receives FDD products and ingests them into the 
operational database (see Figure 3.1.3-2). The Command Management Subsystem (CMS) 
generates table loads from FDF table files (see Figure 3.1.3-3). The Analysis Subsystem (ANA) 
processes the FDD products listed in Figure 3.1.3-4 to generate statistics and datasets. The 
Planning and Scheduling (PAS) Subsystem utilizes FDD products for updating the Resource 
Model, a repository of PAS states, schedules and plans. In addition, orbit event data is both 
placed and updated on the timeline and plans are adjusted by the Schedule Adjustor to reflect 
changes in event data (see Figure 3.1.3-5). The Event Generator is used to create instrument­
unique orbital events (i.e., MISR Local Mode Events, CERES Solar Avoidance Event). Finally, 
DMS FTPs files to ISTs as illustrated in Figure 3.1.3-6 and provides data to the DAAC for 
archival (see Section 3.1.8). 

Files ingested by DMS are periodically purged, since this data is archived at the DAAC. The FOT 
can configure the length of time data in the various FDD tables is maintained. This configuration 
information is in the fos_dbpurge database table. 
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DATA MGMT SYSTEM DATA MGMT SYSTEM DATA MGMT SYSTEM 

FTP FROM FDD	 •Files are placed 
in external/fdf directory 

•Bulk copy script used 
to copy files to 
unvalidated database 
am1_fos_unv 

•Validate files via triggers:

- Header Record- file type correct 
- Field 
- Data Record-field correctness 

OR IF VALIDATION FAILS 

•Error file is generated 
DATA MGMT SYSTEM 

DATA MGMT SYSTEM 

IF VALIDATION SUCCEEDS 

correctness 

•Data moved via Fdf_val_log 
gen_op.script to •Event message sent to FOT 
am1_fos_ops 
(valid db->oper­
ational db) 

DATA MGMT SYSTEM 

•Internal event message 
sent to PAS, ANA, IOT 
and FOT 

DATA MGMT SYSTEM 

Figure 3.1.3-2. DMS Ingests FDD Products 

DATA MGMT SYSTEM DATA MGMT SYSTEM COMMAND MGMT SYSTEM 

•Report generated containing error 
message (report is on web) 
•Entire file is not used 

•FOT notifies FDD and receives 
new products 

FDD table files are 
placed in database. 

FDD 

Validation of field correctness via triggers. 
Validation criteria in FDD ICD and DFCD. 

Load requested from 
(CMS). 

CMS automatically 
generates load (.upl, 
.imgd, .cnt files are 
generated). 

Load sent to FOT for 
uplink. 
View load report contents. 

COMMAND MGMT SYSTEM 

Figure 3.1.3-3. CMS Table Load Generation 
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•Receive event 
message from DMS 

•Query database 
•Retrieve data 

And 

•Generate and store 
statistics 

•Generate datasets 

•Data files are placed 
in /statistics and 
/datasets directories 

ANALYSIS 

ANALYSIS 

ANALYSIS 

ANALYSIS 

•Event message sent to 
FOT 

ANALYSIS 

Figure 3.1.3-4. ANA Generation of Statistics and Datasets 

PAS PAS PAS 

•Receive event 
message from DMS 

PAS 

•Query database 
and retrieve data 

• Orbit events are moved into 
Resource Model 

• PAS tools retrieve events 
from Resource Model 

•Events are placed on timeline 

PAS 

•Operator utilizes Schedule 
Adjustor to adjust Master 
Plan once a day 

• FOT and IOT schedule 
activities 

Figure 3.1.3-5. PAS Ingests FDD Data 
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IST USER 

DATA MGMT 

files 
IST user receives FDD 

SYSTEM 

FTP files to IST users 

Receive event message 
from DMS 

IST USER 

Figure 3.1.3-6. DMS FTPs Files to ISTs 

3.1.4 IP-ICC Interface 

International Partners (IP) may provide their own Instrument Control Center (ICC) for their 
instrument onboard an EOS spacecraft. For example, Japan will provide an IP-ICC for the 
Advanced Spaceborne Thermal Emission and Reflection Radiometer (ASTER) instrument onboard 
the AM-1 spacecraft. 

The IP-ICC provides instrument plans and schedules to EOC, and coordinates scheduling conflicts 
with EOC when they arise. The EOC sends planning aids and integrated mission plans and 
schedules to the IP-ICC for analysis to refine instrument scheduling. 

An IP-ICC can send instrument real-time command requests to the EOC. If approved by the FOT, 
EOC sends requested commands to the spacecraft via the EDOS interface. The EOC reports on 
uplink status to the IP-ICC. In addition, EOC can send commands to the spacecraft on behalf of 
the instrument (e.g., to safe the instrument). The EOC notifies the IP-ICC with a command 
notification message in this situation. 

An IP-ICC can send instrument data base update requests to the EOC. After the database update 
request has been approved, or whenever a new project database has been established in the EOC, 
the updated project database will be sent to the IP-ICC. 

Periodically, the FOT sends spacecraft and mission status information to the IP-ICC, and the IP-
ICC sends instrument status to the FOT. 
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Data interfaces between the ASTER ICC and EOC are specified in the ICD Between ECS and the 
ASTER Ground Data System. 

3.1.5 SDVF Interface 

The SDVF sends flight software loads to the EOC. These loads are scheduled by EOC for 
subsequent uplink to the spacecraft. The EOC may send flight software memory dumps to the 
SDVF. 

Data interfaces between SDVF and EOC are specified in the ICD Between ECS and the Spacecraft 
SDVFs. 

3.1.6 Spacecraft Simulator Interface 

The EOC sends spacecraft and instrument commands to the Spacecraft Simulator. The Spacecraft 
Simulator sends simulated spacecraft telemetry to EOC. The EOC interfaces with the Spacecraft 
Simulator via the EOSDIS Test System (ETS) interface. The Spacecraft Simulator is used for 
flight operations training and development, and to validate operational procedures. 

Data interfaces between the AM-1 Spacecraft Simulator and EOC are specified in the Spacecraft 
Simulator/EOC ICD. 

3.1.7 SCF (IST) Interface 

Microprocessor memory loads for instruments will be submitted to the EOC from SCF through the 
IST. These microprocessor memory loads are scheduled by EOC for subsequent uplink to the 
spacecraft. The EOC sends microprocessor memory dumps to SCF via the IST. The SCF also 
has a general interface with the EOC through the IST toolkit to import and export other data (e.g., 
telemetry data files). 

3.1.8 DAAC Interface 

The GSFC DAAC provides long-term archiving services for flight operations data as illustrated in 
Figure 3.1.8-1. Data sent to the GSFC DAAC includes spacecraft and instrument housekeeping 
telemetry, event history data, etc. Additionally, EOC sends mission plans and schedules to the 
GSFC DAAC. The GSFC DAAC also processes requests for flight operations data that has been 
previously stored in the long-term archive, and delivers this data to EOC upon request. Refer to 
the FOS Science Data Processing Segment (SDPS) Data Archive and Retrieval White Paper 
(document number to be assigned, expected release 12/97) for additional information. 

DATA MGMT SYSTEM DATA MGMT SYSTEM DAAC 

•DMS valid database •Files are retrieved from 
valid database 

•Files are archived within 
24 hours of receipt 

•Sent to DAAC for long term 

am1_fos_ops archival 

Figure 3.1.8-1. Data Archival at the DAAC 
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3.1.9 SMC Interface 

The SMC sends Long-Term Instrument Plans and Long-Term Science Plans to the EOC. These 
sets of plans are produced/updated by the Investigator Working Group (IWG) every 6 months 
and cover a period of up to 5 years. 

3.2 Flight Operations Services 

Nine services have been defined to support flight operations. These services are: Planning and 
Scheduling, Command Management, Command, Telemetry, Resource Management, Real-Time 
Contact Management, Analysis, Data Management, and User Interface. Individually, these services 
perform specific, unique functions; collectively, they provide a set of interrelated services for the 
FOT and the IST user community. 

Paragraphs 3.2.1 through 3.2.4 are descriptions of the nine flight operations services organized to 
support the flight operations activity phases. 

3.2.1 Scheduling Phase 

1.	 Planning and Scheduling. The Planning and Scheduling service integrates plans and 
schedules for spacecraft, instruments, and ground operations, and coordinates multi­
instrument observations, if necessary. The Planning and Scheduling provides the FOT 
with a common set of capabilities to perform “what-if” analyses, and to visualize plans and 
schedules. 

This service allows PI/TLs to actively participate in the EOS mission planning process 
through the planning and scheduling tools in the IST toolkit. The toolkit provides global 
visibility into the mission timeline and the set of scheduling products generated at EOC. 

2.	 Command Management. The Command Management service manages pre-planned 
command data for the spacecraft and instruments. Based on inputs received from the 
Planning and Scheduling service, Command Management service collects and validates 
commands, software memory loads, table loads, and instrument memory loads necessary 
to implement the instrument and spacecraft scheduled activities. 

3.	 Real-Time Contact Management. The Real-Time Contact Management service manages the 
real-time interface with the NCC and EDOS. 

3.2.2 Real-Time Phase 

1.	 Command. The Command service transmits command data (i.e., real-time commands or 
command loads) to EDOS for uplink to the spacecraft during each real-time contact. 
Command data can be supplied in real-time by the FOT or as pre-planned command groups 
generated by the Command Management service. The Command service is also 
responsible for verifying command execution onboard the spacecraft. 

3-11 609-CD-005-004




2.	 Telemetry. The Telemetry service receives and processes housekeeping telemetry [in 
Consultative Committee for Space Data Systems (CCSDS) packets] from EDOS. After 
packet decommutation, the telemetry data is converted to Engineering Units (EU) and 
checked against boundary limits. 

3.2.3 Analysis Phase 

Analysis. The Analysis service is responsible for managing the on-board systems and for 
the overall mission monitoring. Its functions include performance analysis and trend 
analysis. It also cooperates with the Telemetry service to support fault detection and 
isolation. 

3.2.4 Support Services 

1.	 Resource Management. The Resource Management service provides the FOT with the 
capability to manage and monitor EOC’s configuration. This includes configuring EOC 
resources for multi-mission support; facilitating operational failure recovery during real­
time contacts. 

2.	 Data Management. The Data Management service maintains and updates the Project Data 
Base (PDB) and the EOC history log. 

3.	 User Interface. The User Interface service provides character-based and graphical display 
interfaces for FOT operators and PI/TLs (using the IST) interacting with all of the 
aforementioned flight operations services. 

3.3 FOT Overview 

The ECS FOT will operate the EOC’s FOS. The FOT also will operate the EOS spacecraft and 
instruments, as well as monitor the health and performance of these flight elements, and maintain 
the FOS system. The FOT consists of four sections (Management, Operations, Flight 
Engineering, and Ground System Engineering). Specific FOT positions are as follows: 

1. FOT Management. 

a. Project Support Manager. 

b. FOT Configuration Management (CM) Coordinator. 

c. FOT Performance Assurance (PA) Coordinator. 

d. FOT Training Coordinator. 

e. FOT Administrative Assistant. 

2. FOT Operations. 

a. FOT Operations Manager. 

b. FOT Operations Coordinator. 

c. FOT Operations Controller/Shift Supervisor. 
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d. FOT Spacecraft Activity Controller. 

e. FOT Mission Planner/Supervisor. 

f .  FOT Planner/Scheduler. 

3. FOT Flight Engineering. 

a. FOT Flight Systems Engineer. 

b. FOT Off-Line Engineer. 

c. FOT Spacecraft Evaluator. 

d. FOT Instrument Evaluator. 

4. FOT Ground System Engineering. 

a. FOT Ground System Engineer. 

b. FOT Database Manager. 

For more detailed information regarding FOT responsibilities, refer to the Maintenance and 
Operations Manual for the ECS Project, 607-CD-001-002. 

3.4 FOT Interaction with FOS Services 

This paragraph provides a high-level discussion of flight operation concepts and supporting FOS 
services. For more detailed scenarios describing FOS operations and FOT interactions with FOS 
services, refer to Operations Scenarios for the ECS Project (FOS), 605-CD-003-001. 

EOS spacecraft planning, scheduling, commanding, and telemetry monitoring will be performed 
by the FOT on a spacecraft-by-spacecraft basis. Parallel but separate configurations (e.g., 
databases, schedules, commands, and archive files) will be maintained for each EOS spacecraft. 
The FOT Spacecraft Activity Controller executes ground scripts that send commands and command 
loads to the spacecraft. Constraints are checked to ensure that only the single authenticated 
Spacecraft Activity Controller position has authority to send commands to the spacecraft. This 
approach facilitates concurrent support of multiple spacecraft with different science goals and 
overlapping TDRSS contacts. 

The health and safety of multiple instruments can be monitored by a single FOT Instrument 
Evaluator due to the nature of the instruments, which are primarily non-complex. 

The separate configuration approach is also applied to replacing an EOS spacecraft within a series. 
For example, separate configurations are maintained for the AM-1 and AM-2 spacecraft. Similarly, 
this approach enables the FOT to perform ongoing support for spacecraft in-orbit and spacecraft in 
the operations testing phase. The FOS can be configured so that support of multiple spacecraft in­
orbit is physically separated from operations associated with spacecraft in the operations testing 
phase. This capability provides an additional level of control and security to flight operations. 
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3.4.1 Planning and Scheduling Operations and Services 

The Planning and Scheduling service coordinates and integrates instrument and spacecraft bus 
command and control requests. It requires cooperative efforts between the FOT planning and 
scheduling staff, the instrument planning and scheduling staff, and the PI/TL representatives. The 
PI/TLs interact with the FOT Planner/Schedulers to ensure that their instruments are configured to 
collect the desired science data and ensure instrument quality. These requests are submitted to 
Planner/Schedulers as activities. The Planner/Schedulers constraint check submitted activities, 
assign priorities, and develop a schedule of activities for the instrument. The Planner/Schedulers 
configure the spacecraft bus subsystems to efficiently use spacecraft resources and execute orbital 
maneuvers. In addition, Planner/Schedulers integrate instrument and spacecraft subsystem 
activities into an overall mission schedule. The final Detailed Activity Schedules are available to the 
PI/TLs through their IST. 

3.4.2 Command Management Operations and Services 

The Command Management service uses the Detailed Activity Schedule previously developed to 
generate ground scripts used during a real-time contact with the spacecraft to send commands and 
command loads, including Spacecraft Controls Computer (SCC) loads and microprocessor 
memory loads. The Planner/Scheduler integrates this command data, with spacecraft subsystem 
commands and command loads, into a ground script. In addition to command data, the ground 
script includes the directives required to configure the ground system to support pre-contact, 
contact, and post-contact operations. 

3.4.3 Command and Telemetry Operations and Services 

The Command and Telemetry services provide the Spacecraft Activity Controller the ability to 
execute the ground script generated for that day's activities by the Planner/Schedulers. The 
Spacecraft Activity Controller verifies that stored commands are successfully loaded onboard the 
spacecraft for subsequent execution, as well as the loading and execution of real-time commands. 
The Spacecraft Evaluator monitors telemetry housekeeping data downlinked from the spacecraft. In 
parallel, the instrument housekeeping telemetry is monitored by the Instrument Evaluator at the 
EOC, and/or PI/TL at the IST. 

3.4.4 Analysis Operations and Services 

The Spacecraft Analysis service provides the FOT Spacecraft Evaluator, Instrument Evaluator, and 
Off-Line Engineers a set of tools to analyze spacecraft and instrument performance anomalies and 
deviations from expected performance standards. In particular, Off-Line Engineers routinely 
analyze housekeeping telemetry trend data concerning spacecraft subsystems to identify 
performance fluctuation issues (e.g., battery performance). Specific tools aimed at evaluating the 
functions, resources, and performance of spacecraft subsystems are also routinely exercised by the 
Spacecraft Evaluator and Off-Line Engineers. 
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4. EOC System Operations 

4.1 Introduction 

This section describes how to use the tools that assure appropriate EOC hardware performance as 
well as how to initialize the Sybase, Real-Time and Data servers. Most parts of this section are 
intended only for FOS System Administrators. Only paragraphs 4.2.3, 4.2.4, and 4.3 are 
intended for FOS users. If any part of the initialization process requires root access, contact FOS 
System Administrators. 

4.2 Initializing the DEC Polycenter Console Manager 

This paragraph describes system initialization functions including: using Digital Equipment 
Corporation (DEC) Console Managers to access DEC userstations; initializing the Redundant Array 
of Inexpensive Disks (RAID) system; starting up the Sybase servers; and starting up FOS 
software. Paragraph 4.3 describes system shutdown including terminating the FOS software and 
system administrator commands for hardware shutdown. Figure 4.1-1 is the network diagram 
illustrating the EOC network’s layout. Refer to the Segment Level volume of the FOS Release B 
Design Specification (305-CD-040-002) for a discussion of the EOC network. 

4.2.1 Hardware Initialization 

The DEC Console Managers must be started first. DEC Polycenter Console Manager software 
operates the DEC servers. The DEC RAIDs and the RAID Servers (opsraid on either cheetah or 
lion and supraid on cougar) need to be on-line before any of the other machines. The RAID 
contains users’ home directories and the operational FOS software (in /fos) that needs to be 
mounted by the other machines. The DEC RAID must be initialized before the RAID Server. 

To start the two DEC Console Managers: 

1.	 If not already done, power on the Local Area Transport (LAT) servers by plugging them 
in. The LAT servers do not have power switches, so to be power-cycled they must be 
unplugged and re-plugged. The LAT servers are the small, flat boxes with multiple 
Ethernet connections next to the Console Managers. 

2. Power-on the DEC Console Managers and login as the root  user. 

3.	 In a terminal window on each console, type console -c3 to start the DEC Polycenter 
Console Manager (see Figure 4.2.1-1). 

4.	 In the POLYCENTER Console Manager C3 window, select Console Manager from the 
Commands menu, then select Startup. 

The DEC server icons will become highlighted. The lights on the LAT servers must also 
come on for each connected Ethernet cable. If these events do not occur, refer to the FOS 
EOC Installation Manual to make sure the LAT servers are connected properly to the 
appropriate Console Manager. 
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4.2.2 Initializing the DEC RAID and RAID Servers 

Once the Console Managers are up and the DEC Polycenter Console Manager software is running 
properly, make sure the RAID disks are plugged in. If any disks have an orange or red light on, 
ensure that the disks are using the arc utility. 

To run the arc utility: 

1.	 Connect to the RAID Server by double clicking on the appropriate icon in the Polycenter 
window on the Console Manager connected to the RAID. This brings up a terminal 
window. 

NOTE 

When other DEC servers are powered-on, users can double click on their 
corresponding icons in the Polycenter window on the corresponding Console 
Manager. Each console is connected to specific DECs. Therefore, if a double 
click on one icon does not connect, try the other Console Manager. If it still 
does not connect, it indicates that the LAT servers did not properly initialize. 

2. When the terminal window opens, press <Return> to receive the login prompt. 

3.	 Login as root and type /usr/sbin/shutdown -h now to receive the chevron (“>>>”) 
prompt. 

4. Type arc to start the utility that sets up the RAID. 

5.	 The arc utility only works in 8-bit mode, so in the Terminal window menu, select 
Options and then General. This opens a window of options for that terminal window. 

6. Select VT300, 8-bit Controls, and VT220 terminal type. 

7. Click Apply, but do not save these changes. 

8. In the arc utility, choose Run a program. 

9.	 Type a:srlmgr to run the RAID software on the 3.5 inch disk currently in the cougar disk 
drive. If the disk is not there, look for a disk in the RAID cabinet near the Tape Drive 
Stacker labeled: “StorageWorks, Standalone RAID array, Software version 3.2, for AIX 
systems.” Do not lose this disk! It is required for RAID system initialization. 

10. Choose View Configuration. 

11. Choose View/Define Drive Group to display each RAID drive’s current state 

12. The drive specified “HSP” is the hot spare. Any drives specified “FLD” have failed. To 
correct this, press <Esc> twice to get back to the Main menu and continue with step 13. If 
all drives have “OPT” specified, press <Esc> to get out of the arc utility and skip to step 
15. 

13. Select Make Optimal from the Tools menu. 
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14. Make each drive specified “FLD” to be “optimal” by following the menus and directions. 
If the drives still do not become optimal, cycle the power to the RAID by unplugging and 
then re-plugging the unit. Restart the process of running the arc utility. If a drive cannot 
be made optimal, it must be replaced. 

15. After all drives have been made optimal, press <Esc> twice to return to the Main menu, 
turn the RAID Server off, and then back on. The RAID Server should boot and the RAID 
disks will be available. 

After the DEC RAID and RAID Server are running, all other machines can be turned on in any 
order. 

4.2.3 Sybase Server Initialization 

In order to run FOS software, the Sybase Database servers must first be started on the Data 
servers. This should occur automatically when the machines are powered-on. If for some reason 
the Sybase servers do not initialize, the following procedure can be used. For passwords or 
assistance, contact the FOS Data Management Subsystem (DMS) development lead. 

To determine if the Sybase servers are running: 

1. Login to the Data servers as the user sybase. 

2.	 Type cd install to get to the /vendor/sybase/install directory (this is a symbolic link to 
/usr/sybase/install). 

3. Type showserver. 

4.	 If a process similar to /usr/sybase/bin/dataserver -d 
/usr/sybase/devices/master.dat is shown, then the Sybase server is running. 

To start the Sybases servers: 

1. Login to the Data servers as the user sybase. 

2.	 Type cd install to get to the /vendor/sybase/install directory (which is a symbolic link to 
/usr/sybase/install). 

3.	 Type startserver -f <database RUN file>, where <database RUN file> is determined 
from the following list: 

Machine Name <database RUN file> 

panther RUN_fos1_srvr 

jaguar RUN_ds2_srvr 

tiger RUN_ds3_srvr 
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4.2.4 FOS Software Initialization 

To access FOS applications, first initialize FOS Data and Real-Time servers in the order presented 
below. Where possible, to facilitate monitoring of system messages, designate a userstation as the 
initialization userstation and do not run the FOS software on that station. 

In order to initialize the Data server, you must log into the machine which is going to run the Data 
server. This may be done from that machine’s console or by logging in remotely. The same is 
true for a Real-Time server. Once the data server is brought up, a userstation may be started by 
performing the steps described in Section 5. 

4.2.4.1 FOS Data Server Initialization 

The FOS software should be operated in the Motif windowing environment. Refer to your specific 
windowing interface documents for instructions on initializing the Motif windowing environment. 

a.	 Remotely login to the FOS Data server via telnet by placing the cursor in the xterm, CMD 
or terminal window to make it the active window. 

The system prompt must indicate the new hostname. If not, repeat the login procedure. 

b. If necessary, open a xterm, CMD or terminal window. 

c. Place the cursor in a second window. Start netscape by entering netscape &. 

d.	 In Netscape, bring up the FOS homepage by selecting FOS Database Page under the 
Bookmarks menu. If the Bookmark is unavailable, enter the URL for the FOS Database 
page “http://www.eoc.ecs.nasa.gov/FosDbHome.htm1”. 

e.	 On the FOS homepage, under "EOC Test Databases", click on NameServerDatabase. 
Enter the Data server hostname in the "EntryId" field and click Submit. Verify that no 
endpoints exist by running the show.sh script from the /fosb/test/am1/scripts/setup 
directory. If endpoints are found, verify that no other user has started the data server. If 
necessary, remove endpoints by running the rm_all.sh script at the prompt from the 
/fosb/test/am1/scripts/setup directory. 

NOTE 

An alternative to viewing endpoints in steps 3, 4, and 5 is to run the show.sh 
script from the scripts/setup directory by entering the following commands: 

cd /fosb/test/am1/scripts/setup 

show.sh 

f. 	 Terminate any processes running on the Data server by following the steps outlined in 
paragraph 4.3.1.1. 

g.	 Place the cursor in a second window. Change to the FOS software setup directory and run 
the Data server startup script. 
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cd /fosb/test/am1/scripts/setup 

source DataServerStartup 

System messages will scroll showing the loading sequence. 

h.	 Enter the Data server hostname in the "EntryId" field and click Submit. Verify that there 
are 76 endpoints. After initializing the Data server, if the Name server form is submitted 
without a hostname in the "EntryId" field, 126 endpoints will be returned. These include 
76 registered with the Name server and 50 registered with IP addresses. 

If the number of endpoints is not 76, type MyKill at the prompt from the 
/fosb/test/am1/scripts/setup directory to terminate the processes running on the Data server. 
Repeat steps 6 through 8 to restart the FOS Data server. 

NOTE 

The correct number of endpoints registered with the Real-Time and Data servers 
will change over time as software patches are delivered. Check with the FOT 
System Administrator for the current number of endpoints that should be 
registered after each server is initialized. 

i.	 To further ensure proper initialization, check processes by remotely login to the FOS Data 
server via telnet and typing ps -ea |more. Verify that all processes listed in Table 4.3.1-1 
appear. 

4.2.4.2 FOS Real-Time Server Initialization 

After initializing the FOS Data server, perform the following steps to initialize the FOS Real-Time 
server. 

a. In the active terminal window, remotely login to the FOS Real-Time server via telnet. 

The system prompt must indicate the new hostname. If not, repeat the login procedure. 

b. Place the cursor in a second window. Start netscape by entering netscape &. 

c.	 In Netscape bring up the FOS homepage by selecting FOS Database Page under the 
Bookmarks menu. If the Bookmark is unavailable, enter the URL for the FOS Database 
page “http://www.eoc.ecs.nasa.gov/FosDbHome.htm1”. 

d.	 On the FOS homepage, under "EOC Test Databases", click on NameServerDatabase. 
Enter the Real-Time server hostname in the "EntryId" field and click Submit. Verify that 
no endpoints exist by running the show.sh script. If endpoints are found, verify that no 
other user has started the Real-Time server. If necessary, remove endpoints by running the 
rm_all.sh script at the prompt from the /fosb/test/am1/scripts/setup directory. 
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NOTE 

An alternative to viewing endpoints in steps 2, 3, and 4 is to run the show.sh 
script from the scripts/setup directory by entering the following commands: 

cd/fosb/test/am1/scripts/setup 

show.sh 

e.	 Terminate any processes running on the Real-Time server by following the steps outlined 
in paragraph 4.3.1.1. 

f. 	 Change to the FOS software setup directory and run the Real-Time server startup script. 

cd /fosb/test/am1/scripts/setup 

source RealTime ServerStartup 

System messages will scroll showing the loading sequence 

g.	 On the FOS homepage, under "EOC Test Database Page", click on 
NameServerDatabase. Enter the Real-Time server hostname in the "EntryId" field 
and click Submit. Verify that there are 33 endpoints. 

If the number of endpoints is not 33, enter MyKill at the prompt from the 
/fosb/test/am1/scripts/setup directory to terminate the processes running on the Real-Time 
server. Repeat steps 5-7 to restart the Real-Time server. 

h.	 To further ensure proper initialization , check processes by remotely login to the FOS Real-
Time server via telnet and typing ps -ea |more. Verify that all processes listed in Table 
4.3.1-1 appear. 

4.3 System Shutdown 

FOS provides a script to shut down FOS application processes. To shut down FOS applications, 
execute the MyKill script from the /fosb/test/am1/scripts/setup directory. The script may be 
executed from a xterm or cmdtool window. The script will take several minutes to complete as 
each FOS application terminates. 

FOS software should be shut down in the following order: Real-Time server, userstations, then 
Data server. 

Enter the following commands to shut down FOS applications: 

cd /fosb/test/am1/scripts/setup 

MyKill 

In rare cases, some endpoints may not be deregistered from the Data or Real-Time servers after 
execution of the MyKill script. If endpoints are returned when the EOC Test Database form is 
submitted, the remaining endpoints should be removed manually. 
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To check on and remove endpoints from the Real-Time server by running the show.sh and 
rm_all.sh scripts from the scripts/setup directory: 

1. cd /fosb/test/am1/scripts/setup 

2. show.sh 

3. rm.sh 

or 

Open the Name Server Database form by clicking NameServerDatabase on the 
FOS homepage. On the form, enter the Real-Time server’s Id in the "EntryId" field, 
type the password required to manually remove endpoints in the "Remove Password" 
field and click Submit. 

The Data server must be brought down prior to removing endpoints. To check on and remove 
endpoints from the Data server (and those registered with IP addresses) by running the show.sh 
and rm_all.sh scripts from the scripts/setup directory: 

1. cd /fosb/test/am1/scripts/setup 

2. show.sh 

3. rm_all.sh 

or 

Open the Name Server Database form by clicking NameServerDatabase on the 
FOS homepage. On the form, leave the "EntryId" field blank, type the password 
required to manually remove endpoints in the "Remove Password" field and click 
Submit. 

4.3.1 FOS Application Processes 

Table 4.3.1-1 lists FOS application processes that should shut down when the MyKill script is 
run. Any of the processes not shut down must be manually terminated. 

4.3.1.1 Manually Terminate Active FOS Processes 

Enter the appropriate UNIX ps command to generate an onscreen list of active processes. 
Depending on the operating system version, the ps command options will vary. If any FOS 
processes, listed in Table 4.3.1-1, are active after the MyKill script has completed, they must be 
manually terminated via the UNIX kill command. To manually terminate any remaining active 
FOS processes, enter the UNIX command kill -2 <pid>, where <pid> is the process ID (pid) of 
an active FOS process. Type the ps command again to validate the process is no longer active. If 
a FOS process is still active, type the UNIX command kill -9 <pid>. This command is guaranteed 
to terminate the process, as long as the process is associated with the user who enters the kill 
command. Users may only kill processes associated with their user ID. The System 
Administrator is the only one who can kill processes associated with another user ID. 
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Table 4.3.1-1. FOS Application Processes 
Userstation Data Server Real-Time Server 

DisplayBuilder.ini FaCsReportMonitor FaAlActivityLogMonitor 

FaAcCruncher FdDbActivityArchive FcCdFormat 

FaCcClockCorrelation FdDbDiskCleaner FcCmFop 

FaDssIE FdDbEventDbSrv FcCmXmit 

FaFdfAnalysis FdDbFileMetaServer FdEvEventHandler 

FaIeSSR FdDbLoadCatSrv FgEiEdosIn 

FaPrEdosNcc FdDbOrbitEventServer FgEoEdosOut 

FaRmRequestManager FdDbTableDefSrv FgGmNccGroundMgr 

FaRtDServer FdDbTlmCataServer FgSmNccStatusMgr 

FdArTlmArchiver FdDrTlmRetriever FoNsNameServer 

FdDbOdfTable FdEvEventArchiver FoPlRequestReceiver 

FdDrTlmRetriever FdEvEventHandler FrGrStringMgr 

FdEvEventHandler FdEvEventRouter FrRmResourceMonitor 

FdPbPlaybackMerge FdFwFileWatcher FrRpRepeater 

FoNsNameServer FdLtLongTermIf FtDcDecom 

FoUaDatabaseCmdLineClient FdQmQueueMgr FtMdDump 

FoUaEncryptUtility FdUrUserRolesArchive FtScStateCheck 

FpAdActivityDefiner FmCcAM1ConstraintATC FuGsGroundScriptControl 

FpArActivityRecycler FmCcAM1ConstraintAct upd 

FpAvActivityValidator FmCcAM1ConstraintProc 

FpBdBapDefiner FmCcAM1ConstraintRTS 

FpCdConstraintDefiner FmCcDBStartNotifier 

FpCsCommContactScheduler FmCcDefinitionConstCk 

FpCvConstraintValidator FmGsGroundSchedule 

FpDdDataDistributor FmImAM1MemoryImage 

FpEhEventHandler FmLdAM1LoadCatalog 

FpFsAsterFilter FmMmAM1SpacecraftModel 

FpGsGeneralScheduler FoNsNameServer 

FpLgLoadGenerator FoPsParameterServer 

FpLsLoadScheduler FoRfReflector 

FpNsNameServer FoSwNameServerSweeper 

FpPtTimeline FoTvClient 

FpPvPlanValidator FoTvGenMapOdf 

FpRmResourceModel FoTvServer 

FpRpReports FoUaServer 

FpSaScheduleAdjustor FpDdDataDistributor 

FrGrStringMgr FpEhEventHandler 

FrRpRepeater FpLqLoadQueuer 

FpTlTimeline FpNiNccIngester 
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Table 4.3.1-1. FOS Application Processes (continued) 
Userstation Data Server Real-Time Server 

FtPgPackGen FpNsNameServer 

FuAdAtcBuffer FpRmResourceModel 

FuAnAlgReg FpSuSSRUpdater 

FuAnBuild FuClParserServer 

FuAnHandler FuCrCmdRequestHandler 

FuBbBinLoadBuilder FuSoManager 

FuCcCmdControl FmScAM1ScheduleController 

FuCrCmdRequest 

FuCsTranslate 

FuCwControlWindow 

FuDbDisplayBuilder 

FuDbWriteDefs 

FuDbWritePms 

FuDmDataMover 

FuEcEnvCtrl 

FuEmMail 

FuEvEvtdis 

FuEvEvtdisLocal 

FuGdGrndDisplayWin 

FuIwDisplay 

FuLbTableLoadBuilder 

FuPbProcBuilderWin 

FuPcProcController 

FuPwProcControlWin 

FuQaQuickAnalysis 

FuQmQuickMsg 

FuRbRoomBuilder 

FuRcReplayController 

FuRdRTSWin 

FuRlRTSLoadBuilderWin 

FuRmWriteRoom 

FuRpReport 

FuSbSOBrowser 

FuScBuild 

FuScDisplay 

FuScHci 

FuTdDynamicPage 

FuTsEventDataFile 

4-10 609-CD-005-004




Table 4.3.1-1. FOS Application Processes (continued) 
Userstation Data Server Real-Time Server 

FuUaLogin 

FuUaMakeRoles 

FuUaWriteConfig 

FuUcUserCustomization 

FuUtSessionServer 

FuWcClock 

evtdis.uid 

4.3.2 Hardware Shutdown 

Maintenance or software troubleshooting may require hardware shutdown. The method for 
hardware shutdown is dependent on the type of machine involved. The RAID server and RAID 
should be shut down last. User stations, Real-Time and Data servers can be shut down in any 
order. 

NOTE 

Prior to shutting down a userstation or server, FOS software associated with 
the hardware should be shut down. 

1.	 On a Sun machine, to shut down the hardware immediately, run one of the following 
commands as the root user: 

/usr/ucb/shutdown -h now 

/usr/sbin/shutdown -y -g0 -i0 

If a delay before shutdown is desired, replace now with +n, where n is some number of 
minutes, or change the number after -g to the number of seconds to wait before shutdown 
actually occurs. 

2.	 On a DEC machine, to perform shutdown immediately, enter the following command as 
the root user: 

/usr/sbin/shutdown -h now 

If a delay before shutdown is desired, replace now with +n, where n is some number of 
minutes. 

3.	 On a Hewlett Packard (HP) machine, to perform shutdown immediately, enter the 
following command as the root user: 

/etc/shutdown -h now 

If a delay before shutdown is desired, replace now with +n, where n is the number of 
seconds to wait before shutdown occurs. 

After the systems have shut down, you may turn off the power. 
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5. Userstation Operations 

5.1 UNIX Login 

In order to execute FOS applications, you must first login to the UNIX userstation, initialize the 
software on the userstation, register with FOS, and select a user role. The UNIX login procedure 
is similar for all UNIX userstation; a user name and password are entered at the appropriate 
prompts. 

Passwords must be protected to ensure system integrity. Different versions of the UNIX operating 
system may enforce slightly different standards, but you should adhere to the following rules when 
selecting a password. 

a. Passwords should be a minimum of eight characters. 

b.	 Passwords should not be words that can be associated with a user (e.g., your child’s 
name, favorite sport, your dog’s name, etc.). 

c.	 Passwords should not be words that can be found in any dictionary of human language. 
For example, containing a combination of alphanumeric and special characters. 

The user name and password file is maintained by the UNIX System Administrator. Typically, a 
default password is provided for the initial login. Users change this password the first time they 
login to the system. The System Administrator is also responsible for deleting old user names and 
passwords. The mechanism for maintaining user names and passwords is described in the 
platform-specific documentation for the network. 

After a correct user name/password is entered, the window manager starts. For FOS applications, 
the Motif window manager (i.e., mwm) must be used. Check with the System Administrator to 
verify that mwm is being used. 

5.2 FOS Userstation Startup 

After successfully initializing the FOS Data server (refer to Section 4), userstations can be 
initialized. It is useful to start a userstation prior to initializing the Real-Time server so event 
messages about the Real-Time server can be monitored. 

a.	 Click and hold the right mouse button to activate the Workspace menu and select Programs 
then xterm. 

b. At the system prompt enter the following UNIX commands: 

1. cd /fosb/test/am1/scripts/setup 

2. FOS_LOGIN 
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5.2.1 FOS Login 

FOS login involves entering your user name and password in the FOS Login window and 
selecting a role in the FOS Roles window. See Figure 5.2.1-1. Once FOS software has been 
initialized on the userstation, the FOS Login window opens. Enter your user name and password 
and select the environment (Operational, Test, or Training). To use the software in the 
standalone mode, not connected to the EOC Data or Real-Time Servers, click Standalone 
Mode . Click OK to submit your user name and password for user authentication. The user 
authentication process involves identifying an individual as a recognized user with specific 
privileges. 

Once your user name and password have been authenticated, the User Roles window opens. The 
user role selected determines the system operations you will be authorized to perform. 

Figure 5.2.1-1. FOS Login Window 

5.2.2 User Roles 

Once you have successfully logged into the FOS software, the user role you assume determines the 
system privileges granted. The User Roles window opens automatically once a valid user name 
and ID are entered via the FOS Login window. Alternatively, the FOS Roles window can be 
opened by clicking Tools... on the Control window and selecting User Roles from the list of 
tools. 

Roles are selected by specifying a spacecraft, site, and role on the User Roles window (see 
Figure 5.2.2-1) and clicking OK to submit the role information. The user role selected is checked 
to confirm that the user is authorized to assume that role for the specified instrument and 
spacecraft. 
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Figure 5.2.2-1. User Roles Window 

A user can be authorized to assume multiple roles, with varying privileges determined by the role. 
Although privileges are instrument-specific, they are not site-specific; in other words an individual 
authorized to assume the Command Activity Controller role for ASTER can assume the same role 
at MODIS. The roles a user can assume and the specific privileges associated with a role are 
defined in the PDB and are updatable. The roles currently defined in the FOS software are listed 
here, as well as a brief description of the primary function of each role. All of the roles listed 
below may be assumed at the EOC. ISTs can assume the Generic, Instrument Controller, Read 
Only, Scheduler, and Definer roles, unless the IST is designated as a “read-only” IST. 

a. Command Activity Controller (CAC). Commands the satellite 

b. Database Administrator (DBA). Maintains the PDB. 

c. INST Controller (INSTCTRL). Oversees spacecraft instrument operation. 

d.	 Operations Controller (OPSCTRL). Responsible for spacecraft and EOC 
operations. 

e. Scheduler. Schedules activities. 

f .  Scheduling Definer (SCHEDDEFINER). Defines and schedules activities. 
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g.	 Generic User. User who has some system privileges. All roles, except the Read Only 
role, are authorized to perform tasks which the Generic User role performs. 

h.	 Read Only. User with read only access to the system. All roles are authorized to 
perform tasks the Read Only role performs. 

All tools accessed subsequent to selecting a role on the User Roles window are brought up in that 
role. Consequently, a user may have different roles simultaneously for different tools. In other 
words, to perform scheduling a user would assume the Scheduler role and open the appropriate 
scheduling tool. Tools accessed prior to assuming the Scheduler role would remain in the role in 
which they were accessed. A list of the current tasks associated with each role may be accessed via 
the FOS home page on the World Wide Web. Tables 5.2.2-1 through 5.2.2-8 identify which FOS 
capabilities are currently associated with each role. 

Table 5.2.2-1. Capabilities Associated with CAC Role 
Build rooms Delete load contents Generate MPR loads Schedule FSW loads 

Control command Delete rooms Generate RTS loads Schedule MPR 

Create command 
requests 

Delete RTS loads Generate Table loads Schedule RTS loads 

Create RTS loads Evaluate command 
requests 

Ingest files 

Delete load catalog Generate FSW loads Monitor command 

Table 5.2.2-2. Capabilities Associated with DBA Role 
Build rooms Delete load contents Generate MPR loads Monitor command 

Create command 
requests 

Delete rooms Generate RTS loads Schedule FSW loads 

Create RTS loads Delete RTS loads Generate Table loads Schedule MPR 

Delete load catalog Generate FSW loads Ingest files Schedule RTS loads 

Table 5.2.2-3. Capabilities Associated with Generic User Role 
Build rooms Create command 

requests 
Delete rooms Ingest files 

Monitor command 

Table 5.2.2-4. Capabilities Associated with Instrument Controller Role 
Build rooms Delete load contents Generate MPR loads Monitor command 

Create command 
requests 

Delete rooms Generate RTS loads Schedule FSW loads 

Create RTS loads Delete RTS loads Generate Table loads Schedule MPR 

Delete load catalog Generate FSW loads Ingest files Schedule RTS loads 
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Table 5.2.2-5. Capabilities Associated with the Operations| 
Controller Role 

Generate MPR loads Delete load contents Generate MPR loads Monitor command 

Control command Delete rooms Generate RTS loads Schedule FSW loads 

Create command 
requests 

Delete RTS loads Generate Table loads Schedule MPR 

Create RTS loads Evaluate Command 
Request 

Ingest files Schedule RTS loads 

Delete load catalog Generate FSW loads Merge command 
requests 

Table 5.2.2-6. Capabilities Associated with the Read Only Role 
Monitor command 

Table 5.2.2-7. Capabilities Associated with the PAS Scheduler Role 
Define BAPs Delete load contents Generate MPR loads Schedule loads 

Build rooms Delete rooms Generate RTS loads Schedule FSW loads 

Schedule contacts Delete RTS loads Generate Table loads Schedule MPR 

Create command 
requests 

Filter scheduling Ingest files Schedule RTS loads 

Create RTS loads General scheduling Generate loads/Unlock 
resources 

Delete load catalog Generate FSW loads Monitor command 

Table 5.2.2-8. Capabilities Associated with the PAS Definer Role 
Define activities Define constraints Filter scheduling Schedule loads 

Define BAPs Schedule contacts General scheduling Generate loads/Unlock 
resources 

5.2.3 Completion of Initialization 

Once a user role has been selected, a dialog box appears indicating that the User Station startup 
script is progressing. System messages will scroll showing the loading sequence (see 
Figure 5.2.3-1). The script is complete when eight planning and scheduling windows, as well as 
the Control window are displayed on the screen. Figure 5.2.3-2 shows the initial configuration of 
the userstation screen once the startup script has completed. The Planning and Scheduling 
windows can be converted to icons by clicking on the small buttons on the top left corner of each 
window to conserve space. 
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Figure 5.2.3-1. Execution of the UserStationStartup Script 
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Figure 5.2.3-2. Window after Initializing the FOS Toolkit on the 
User Station 

5.3 Window Management 

FOS applications are designed to run on a userstation with Motif window manager (mwm) 
software installed. Figure 5.3-1 is a generic Motif Window Manager window. 

5.3.1 Identify the Active Window 

The active window under mwm is determined by the position of the mouse pointer. When you 
move your pointer over a window, the window’s border changes color to indicate it is the active 
window. Before typing in a window, you must first make the window active. Only one window 
is active at a time. 

5.3.2 Access the Window Menu 

Each window has a Window menu enabling manipulation. Click the mouse pointer on the minus 
sign located in the top left corner of a window to access the Window menu. The Window menu 
contains the following options: 

1. Move. Enables you to move the active window. 

2. Size. Enables you to size the active window. 

3. Minimize. Converts the window into an icon. 

4. Restore. Restores an icon to a window (available only for icons). 

5. Maximize. Resizes the window to fill the screen. 

6.	 Lower. Moves the window behind the overlapping open windows on the screen so that it 
is no longer visible. 

7. Close. Closes the window and terminates any active processes in the window. 
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Figure 5.3-1. Generic Motif Window Manager Windows 

5.3.3 Move a Window 

To move a window by clicking and dragging: 

Position the mouse pointer on the window title bar and click and hold the left mouse button. Drag 
the window to the desired location and release the mouse button. 

To move a window using the Window menu move option: 

Click and hold the mouse pointer on the minus sign located in top left corner of a window. Select 
Move from the Window menu and reposition the window by dragging it or pressing the arrow 
keys. Click the left mouse button to deactivate the move function. 

5.3.4 Resize a Window 

You can resize a window by clicking one of its borders or corners and dragging or by selecting 
Size from the Window menu. 

To resize a window by clicking and dragging: 

To change the window’s width, click and hold the left mouse button on the left or right window 
border. Drag the border to the desired location and release the mouse button. To change the 
window’s height, click and hold the left mouse button on the top or bottom window border. Drag 
the border to the desired location and release the mouse button. To resize the width and height of 
the window simultaneously, click and hold the left mouse button in any corner of the window and 
drag. 
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To resize a window using the Window Resize menu option: 

Click and mouse pointer on the minus sign located in top left corner of a window. Select Size 
from the Window menu and press the left/right arrow keys to change the width and the up/down 
arrow keys to change the height. Click the left mouse button to deactivate the resize function. 

5.3.5 Convert a Window to an Icon and Vice Versa 

Convert the active window to an icon by clicking the top right button containing the small dot or by 
selecting Minimize from the Window menu. Restore an icon to a window by positioning the 
mouse pointer on the icon and double clicking the left mouse button or by selecting Restore from 
the Window menu. 

5.3.6 Change a Window’s Level 

Raise a window to the top level of open, overlapping windows on the screen by clicking its border 
with the left mouse button. Move a window behind the open windows on the screen so that it is 
no longer visible by selecting Lower from the Window menu. 

5.3.7 Workspace Menu 

The default Motif Workspace menu contains the window management options. To access the 
Workspace menu, click and hold the right mouse button on an empty area of the desktop. The 
Workspace menu can be customized by editing the .mwmrc file in your home directory; refer to the 
Motif window manager documentation for instructions on customizing the file. 

5.4 Room Management 

The FOS desktop consists of a set of one or more windows grouped together into a room. A room 
is a group of one or more windows saved under a room name. The windows comprising a room 
definition are called pages, and may be tools or dynamic pages. The Control window is persistent 
in every room. The initial room configuration when software is initialized consists of a single 
window (the Control window). The Control window enables you to access rooms, tools and 
dynamic pages; manage windows; enter ECL directives; and monitor, filter, and acknowledge 
events. Planning and Scheduling windows are activated when software is initialized including the 
Activity Definer, Baseline Activity Profile (BAP) Definer, General Scheduler, Load Generator, 
Activity Recycler, and Timeline. 

5.5 Control and Mini Control Windows 

The Control window (see Figure 5.5-1) is persistent or active in all rooms and provides a 
mechanism for selecting tools, entering ECL directives, displaying real-time events, and accessing 
telemetry and ground system parameter displays. The Mini Control window (see Figure 5.5-2) 
provides access to a subset of the capabilities of the Control window. This subset of capabilities 
includes entering ECL directives and accessing the Tile, Default, Rooms..., Tlm Wins..., 
Tools..., Procs..., and Help buttons described in the following text. To switch between the 
Control and Mini Control windows, click the Mini Ctrl button on the Control window or the 
Full Ctrl button on the Mini Control window. 
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Figure 5.5-1. Control Window 

Figure 5.5-2. Mini Control Window 
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5.5.1 Enter ECL Directives 

Enter ECL directives in the ECL command line on the Control or Mini Control windows. 
Spacecraft commands must be entered via the Command Control window; they cannot be entered 
on the Control window. Syntax errors are reported via a dialog box (see Figure 5.5.1-1). To 
view a list containing the last 20 ECL directives, click the arrow button next to the ECL command 
line. Copy a directive from the list to the ECL command line by selecting it in the list. If 
necessary, after modifying the directive, execute it by pressing <Return>. 

Figure 5.5.1-1. Error Dialog Box 

5.5.2 Access Rooms Defined through the Room Builder Tool 

Just below the ECL command line is a row of buttons labeled R1 , R2 , ..., R6 . These buttons 
can be customized to access rooms previously defined through the Room Builder tool. The Room 
Builder tool enables you to create or modify room definitions, including the number and types of 
pages in a room, their positions, sizes, and states (tiled or untiled). Refer to Section 7.4 for 
instructions on customizing room buttons. 

5.5.3 Switch Between Rooms 

The right and left arrow buttons enable you to switch between open rooms. 

1.	 Enter the First Room. Select the name of the room under the Rooms.. .  button on 
theControl window or enter the ROOM directive in the command line of the Control 
window. 

The room definition opens. 

2.	 Enter the Second Room. Select the name of a second room under the Rooms. . .  
button on the Control window or enter the ROOM directive in the command line of the 
Control window. 

The first room is not visible. The second room definition is visible on the screen. 
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5.5.4 Control Window Functionality 

The room buttons (R1 through R6) may be customized to access rooms (refer to Section 7.4). 
The buttons below the room buttons enable you to control the state in which windows are 
displayed on the screen, and to access rooms, dynamic pages, tools, ECL procedures, and help. 

1.	 Tile. Click this button to revert to the tiled definition for the open room. During room 
creation, the room designer specifies the pages - windows or tools - in the room as well as 
their size and position. Each room has a tiled and untiled definition, designated when the 
room is created. Refer to the section on the Room Builder tool for additional information. 

2. Default. Changes the current room definition to its default state. 

3.	 Rooms.... Brings up a dialog box listing room definitions. Select the room definition 
name from the list to switch to that room definition. 

4.	 Tlm Wins.... Opens a dialog box listing telemetry page definitions accessible via the 
Control window. Refer to the Display Builder section for instructions on creating, 
modifying, and making user defined telemetry (dynamic) pages accessible via the Control 
window. Dynamic pages display parameters for vehicles and ground systems. Prior to 
activating a telemetry page using a string, you must connect to that string by entering the 
STRING CONNECT directive. Refer to the section on ECL Directives for additional 
information. Once you have connected to the string(s) associated with a telemetry page, 
bring up a page definition by selecting it from the list. 

5.	 Tools.... Opens the Tool Selection dialog box which provides access to tools, including 
the Room Builder and Display Builder enabling you to create and modify room and 
dynamic page definitions. The list of tools can be filtered to include all tools (All) or by 
software subsystem (Analysis, Commanding, Load Management, Planning & 
Scheduling, or Utilities). Access a tool by selecting it from the list and clicking OK or 
by double clicking the tool. Figure 5.5.4-1 is the Tool Selection dialog box. 

6.	 Procs.... Brings up a dialog box listing ECL procedures. To view system-defined 
procedures, select System. To view user-defined procedures, select User Defined . 
Select a procedure by highlighting it in the list. 

7. Help. Launches Netscape to a context-sensitive help page. 

5.5.5 Monitor and Acknowledge Event Messages 

The right side of the Control window contains a scrolling table displaying the three most recent 
real-time events. Refer to Appendix B for a complete listing of event messages. When event 
messages are displayed in the Control window, they are color coded as one of four message types: 
information - black lettering on gray background; warning - black lettering on yellow background; 
alarm - red lettering on black background; and fatal - white lettering on black background. Alarm 
messages blink on the screen until acknowledged. To acknowledge an alarm message, click the 
blinking message in the Control window and click ACK. 
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Figure 5.5.4-1. Tool Selection Dialog Box 

5.5.6 Filter Events 

Events displayed in the Control window and Local and Global Event Display windows may be 
filtered by spacecraft ID, subsystem event type or string. The event filters are activated by selecting 
S/C ID (spacecraft ID), Subsystem, Event Type, or String ID from the Filter menu of the 
Event Display window. Event types reflect the FOS subsystem that generated the event message. 
Choose any number of filters by selecting or deselecting the corresponding check box. The All 
button selects all filters; None deselects all filters for a respective category (subsystem or type). 
To apply the selected filters to events displayed in the Control window, click Apply. Click 
Cancel to discard any filter changes that have not been applied. 
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Figure 5.5.6-1. Event Filter Dialog Box 

5.5.7 Launch Netscape to a FOS Context Sensitive Help Page 

Help launches Netscape to a context-sensitive help page. 

5.6 System Logout


To exit UNIX, select Logout from the Workspace menu.
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6. ­Entering ECS Command Language (ECL) 
Directives 

6.1 Entering ECL Directives 

ECL directives can be manually entered from the Control, Command Control, or Procedure 
Control window. Directives typed in the command line of a Control window are called manual 
directives. This section describes how users manually enter and execute ECL directives via 
Control windows. Command directives are spacecraft commands proceeded by / or CMD, ground 
directives that effect RCM, RMS, TLM subsystems, which are a subset of ECL, and the 
remaining ECL are referred to as local directives. See Appendix A for a description of all ECL 
directives. 

6.1.1 Enter ECL from the Control Window 

ECL directives can be entered in the ECL command line of either the Control window (see Figure 
6.1.1-1) or the Mini Control window (see Figure 6.1.1-2). A directive’s syntax is checked when 
the <Return> key is pressed. If errors are detected, an error message is displayed in a dialog box. 
Edit the directive in the ECL command line to make necessary corrections. Double click in the text 
field to highlight the nearest word in the ECL command line; triple click to highlight all text. As 
you type, highlighted text is replaced. 

If a directive passes the syntax check, it is sent to the appropriate FOS subsystem for execution. 
The amount of time required to execute a directive may vary greatly depending upon the request. 
For example, creating a new logical string via a STRING CREATE directive may require several 
minutes. Monitor the Event Message window to follow the progress of the directive. Subsequent 
directives may be entered in the Control window’s ECL command line while the initial directive 
executes. 

Command directives cannot be entered from the Control window, only ground directives and local 
directives can be executed. To execute ground directives the user must be connected to a real-time 
logical string control authority; next, the user has to request ground authority by entering the 
TAKE GROUNDCONTROL STRING <stringid> directive, where stringid is the current logical 
string. 

Figure 6.1.1-1. Control Window 

6-1 609-CD-005-004




Figure 6.1.1-2. Mini Control Window 

6.1.2 Entering ECL from the Command Control Window 

The Command Control window (see Figure 6.1.2-1) enables users with command authority for a 
specific logical string to execute and monitor real-time ECL command directives. The command 
control window is the only mechanism for importing manual command directives. In addition to 
spacecraft and instrument, and command execution, the user by entering ECL directives in the 
Command Control window can access logical string processing, and spacecraft and ground 
telemetry monitoring. 

Command directives, only executable via the Command Control window, include all directives 
preceded by / or CMD, as well as the Command subsystem directive SCMD%. Command 
directives entered in the command line of the Control or Procedure Control window will not 
execute. Refer to Section 9 for an in-depth discussion of logical string processing, spacecraft and 
ground telemetry monitoring, and commanding. 

Prior to initiating the Command Control Window the user must request command authority via the 
TAKE COMMAND directive from the Control window (refer to Appendix A, ECL Directives, for 
additional information). If the user does request command authority a Command Monitor Window 
will be displayed. This tool allows the user to monitor command activity, the CMD text entry field 
is grayed out. 

If you have command authority for a specific logical string, you can execute real-time command 
directives when you are connected to the string. Open the Command Control Window by clicking 
Tools… on the Control window and selecting Command Control from the list of tools in the 
Tool Selection dialog box. Alternately, type the appropriate ECL TOOL directive in the Control 
window command line (i.e., TOOL Command_Control). The Command Control dialog box (see 
Figure 6.1.2-2) opens. Enter the string and spacecraft ID in the dialog box and click OK. 

The Command Control window contains a table displaying the date and execution time of the ECL 
directive, ATC location, directive type (manual (M), ground (G), or Procedure (P)), directive text, 
and directive status. The directive type refers to how the command was entered in the command 
control window, and how the command will be executed by the ground script controller. Manual 
(M) indicates the user entered the command or directive from the CMD input line and requires the 
user to click the send/cancel button, ground (G) indicates the command or directive was defined as 
part of a ground script and will execute based on the time stamp assigned to the directive, and 
Procedure (P) implies the command or directive is part of a procedure and will executed 
sequentially within the procedure without user intervention. 
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Figure 6.1.2-1. Command Control Window 

Figure 6.1.2-2. Command Control Dialog Box 
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To enter command directives: 

Command directives may be entered manually, by typing the ECL CMD (/) directive followed by 
the command mnemonic with associated valid submnemonic parameter values into the CMD text 
entry field. Command directives are also entered in automatically via command procedures, 
ground procedures or ground scripts. Command directives include spacecraft commands and 
ground directives. Refer to Appendix A for a complete list of ECL directives and their syntax. 

Before manually entering a command directive, ground scripts must be placed in a suspended 
mode. To suspend ground scripts, click Suspend. Type the directive in the CMD input line, 
press the enter key, the directive will be merged into the ground script display area in the 
Command Control window. Click Resume to continue ground script execution. 

For additional information on creating and editing procedures, refer to the Procedure Builder Tool 
section. For instructions on entering command mnemonics, refer to the Real-Time Services 
section 9 

Validation of command directives: 

When the command is sent by clicking the send button, its syntax is checked and validated against 
the command pdb definitions. Valid commands with valid submnemonics are merged with the 
current set of ground script directives, time stamped, and executed as part of the ground script. If 
the submnemonic name in the command is invalid, a dialog box displays an error message. The 
Status column will indicate if the subfield value is out of range. If this is so, you may override 
the out of range value by clicking Override or cancel the directive by clicking Cancel. 

6.1.3 Entering ECL from the Procedure Control Window 

Refer to section 6.3.1 Executing Procedure, #7 

6.2 ECL Procedures 

An ECL procedure consists of a group of ECL directives that perform a specific task. The 
Procedure Builder tool provides the user the capability to create, edit, syntax check, validate, and 
save ECL procedures. ECL procedures are executed via the Procedure Control, Control, or 
Command Control windows by entering the START directive followed by the procedure name and 
any arguments to the procedure. 

The Directive Builder Tool (see section 6.2.5) facilitates procedure building by allowing you to add 
directives to procedures without having to remember the exact syntax of each directive or command 
mnemonic. The Procedure Control window (see section 6.3.1) enables you to start a procedure as 
well as control and monitor its execution. 

Procedures containing spacecraft commands or ground directives must be executed from the 
Command Control window (see section 6.3.1). Appendix A provides a complete list of ECL 
directives and their syntax, as well as information about using variables in a procedure. 
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6.2.1 Procedure Builder Tool 

On the Control window, click Tools… to open the Tool Selection dialog box. Select 
Procedure Builder from the list of tools or type the appropriate ECL TOOL Procedure_Builder 
directive in the Control window command line. 

The Procedure Builder window consists of six regions (Figure 6.2.1-1): 

1. Menu bar. File, Edit and Tools menus. 

2.	 Procedure file name and type. Procedure types include Activity, Command, 
Emergency, Ground, Local and User Defined. 

3. Procedure text entry area. Box where the text of a procedure is entered. 

4. Status line. Provides status of file operations. 

5.	 Go To text box. Refer to a specific line in the procedure by entering the line number in 
the Go To text box. 

6.	 Syntax and validate buttons and indicators. Perform syntax checking and 
validation. 

Figure 6.2.1-1. Procedure Builder Window 

To select the procedure type: 

Procedures are categorized into various procedure types based on the functions they perform. 
Some procedure types are restricted in terms of the type of directives they may contain (command 
or non-command). When the user validates the procedure the software checks the procedure type. 
If the procedure type is not defined based on the criteria below, the procedure will fail validation 
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(see To perform procedure syntax checking and validation below). There are also 
limitations when executing the various procedure types. Local procedures can be executed via the 
Control Window, Ground procedures require ground authority and can be executed via Control 
Window, Procedure Control Window or Command Control Window. Command and Emergency 
procedures require command authority and can only be executed via Command Control Window. 
(Note: All procedure types can be executed from the Command Control Window) In addition, 
procedure types which may contain one or more command directives may be restricted to ground 
or spacecraft commands as explained below in items a. through f. 

1. Activity. Unrestricted. 

2. Command. Contains at least one spacecraft command. 

3. Emergency. Contains at least one spacecraft command. 

4. Ground. Contains at least one ground directive.. 

5. Local. Contains no spacecraft commands or ground directives. 

6. User Defined. Unrestricted. 

To create a new procedure or open an existing procedure: 

1. Create a new procedure. 

Select New under the File menu of the Procedure Builder window. An ECL procedure 
template is displayed in the Procedure text entry area. 

or 

Open an existing procedure. 

Select Open under the File menu of the Procedure Builder window. The File Selection 
dialog opens (see Figure 6.2.1-2). Click User Dir to display the default directory for 
user defined procedures or System Dir for the directory of System procedures. To filter 
files, enter filter criteria, such as a path or file extension in the Filter text box and click 
Filter. Select the file to open and click OK. The selected procedure file opens. 

2. Select the procedure type. 

Select the procedure type from the Procedure Type pull-down menu: Activity, 
Command, Emergency, Ground, Local or User Defined. 

3. Enter directives in the procedure. 

To enter directives manually place the cursor in the procedure text entry area and begin 
entering directives, or use the Directive Builder Tool (see section 6.2.5). As text is 
entered, the Check Syntax and Validate indicators change to ???? to reflect the fact that the 
status of directives added to the procedure is unknown, since they have not been validated 
or syntax checked. 
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Figure 6.2.1-2. File Selection Dialog Box 

4. Edit text in the procedure. 

Use the Cut, Copy, Paste, and Delete Edit menu options to edit text in the procedure 
text entry area. 

5. Search for or replace text in the procedure. 

Select Find/Replace under the Edit menu. The Find/Replace dialog box opens (see 
Figure 6.2.1-3). 

a. Replace text. 

Type the text to be replaced in the Find box. Enter the replacement text in the Replace 
box or leave the Replace box blank. Click Replace to replace the next occurrence of 
the text or Replace All to replace all occurrences of the text. 

b. Find text. 

Type the text to be found in the Find box. Click Find Next. The next occurrence of 
the Find text is located and highlighted. 

c. Close the Find/Replace dialog box. 

Click Cancel . The dialog box closes. Any text replacements made through 
Replace or Replace All remain in effect. 
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Figure 6.2.1-3. Find/Replace Dialog Box 

To move the cursor to a specific procedure line: 

Move the cursor to a specific line in the procedure text window, and click mouse button, or enter 
the line number in the Go To text entry field in the bottom left corner of the Procedure Builder 
window. 

To perform procedure syntax checking and validation: 

Click Check Syntax to determine if the syntax of directives in the procedure is correct. If the 
procedures syntax is correct, the Check Syntax text box will read PASS. If the procedure contains 
incorrect syntax, the Check Syntax text box will read FAIL and the first incorrect directive will be 
flagged in the Status line along with the line number. Repeat this process until procedure is 
successfully passes. 

Click the Validate button to perform command-level constraint checking. If the submnemonics 
are valid for the mnemonics they are associated with in the procedure, and the procedure definition 
does not violate the constraint definition for the specified command mnemonics, the Validate text 
box will read PASS. If the submnemoics are invalid for the mnemonics they are associated with, 
or a constraint violation has occurred the Validate text box will read FAIL. The invalid 
submnemoics will be flagged in the Status line. 

Procedures must be syntax checked and validated before they are executed. If a procedure has not 
been syntax checked, clicking Validate will syntax check and then validate the procedure. 

To save a new procedure: 

Select Save from the File menu on the Procedure Builder window. The File Selection dialog box 
opens (see Figure 6.2.1-2). By default, all procedures are saved in the default directory for user­
defined procedures, the user’s home directory (i.e., /home/jsmith/procs). 

To save an existing procedure: 

To save an existing procedure under its current file name, select Save from the Procedure Builder 
File menu. To save a procedure with a new name, select Save As from the File menu. The File 
Selection dialog box opens (see Figure 6.2.1-2). 

If you do not enter or select a path in the File Selection dialog box, the procedure is saved in the 
default directory for user-defined procedures, the user’s home directory. To navigate through 
directories in the directories list, specify a path or enter filter criteria in the Filter box and click 

6-8 609-CD-005-004




Filter. Procedures can be saved to the System directory, by clicking System, the directory path 
will be displayed (i.e., /fos/test/am1/procs), enter the procedure name in the selection text box and 
click OK. 

To overwrite an existing procedure: 

Enter a file name in the “Selection” list box or overwrite an existing procedure by selecting it from 
the list of files. Click OK to save the procedure with the name and path specified in the 
“Selection” list box. The File Selection dialog box closes. 

6.2.2 Insert a Procedure into an Open Procedure 

Place the cursor at the location in the procedure text window where the insertion will occur. Select 
Insert under the File menu. The File Selection dialog box opens (see Figure 6.2.1-2). Type the 
path in the Filter text box and select the name of the procedure to be inserted. Click OK to insert 
the procedure at the cursor location in the open file. The procedure is inserted and the File 
Selection dialog box closes. 

6.2.3 Delete a Procedure 

Select Delete from the File menu on the Procedure Builder window. The File Selection dialog 
box opens (see Figure 6.2.1-2). Select a procedure to delete and click OK. A dialog box opens to 
confirm the delete operation. Click Yes to delete the procedure or No to leave the procedure in 
the file directory. The File Selection and confirmation dialog boxes close and the status of the 
delete operation is displayed in the Status line. 

6.2.4 Print a Procedure 

Once you have opened the file to be printed, select Print under the File menu of the Procedure 
Builder window. The procedure text is sent to the printer. 

6.2.5 Add Directives, Commands, or Telemetry Mnemonics to Procedures 
with the Directive Builder Tool 

Place the cursor in the location where you wish to insert the directive, or mnemonic in the open 
procedure. 

To open the Directive Builder: 

Open the Directive Builder Tool (see Figure 6.2.5-1) by selecting Directive Builder... from 
the Procedure Builder Tools menu. The Directive Builder tool enables you to build and insert a 
directive, command mnemonic, or mnemonic into a procedure without having to remember its 
exact syntax. 
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Figure 6.2.5-1. Directive Builder Window 

To insert a directive into a procedure: 

1.	 Select a directive from the list of directive keywords or type a keyword in 
the text box. 

As you type a keyword in the text box, the keyword list scrolls to the first matching 
keyword entry. 

The subdirectives associated with the selected directive are displayed in the “Selection 
Templates” list box. For example, if you select the PAGE directive keyword, the 
subdirectives CLOSE, DELETE, FREEZE, UNFREEZE, ICONIFY, etc., will be listed 
in the “Selection Templates” list box. 

2.	 Double click a directive keyword with the left mouse button to copy it into 
the ECL command line. 

Double click a subdirective with the left mouse button to append it to the directive in the 
ECL command line. 

3.	 Insert the directive into the procedure and leave the Directive Builder 
window open. 

Click Apply to insert the directive into the procedure at the current cursor location. 

or 

Insert the directive into the procedure and close the Directive Builder 
window . 

Click OK to insert the directive into the procedure at the current cursor location and close 
the Directive Builder window. 
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To insert a command mnemonic into a procedure: 

1. List all command mnemonics. 

Click the Cmds toggle button to obtain a list all command mnemonics from which the 
user can select from. 

2. Filter command mnemonics. 

Click Filter to create spacecraft subsystem, or instrument mnemonic. The Selection Filter 
dialog box opens (see Figure 6.2.5-2). Create a filter by selecting a spacecraft under 
“Spacecraft” and a spacecraft subsystem, or instrument under “Instrument” on the Selection 
Filter dialog box. Move the newly created filters to the “Selected” list box by clicking the 
“Scroll Forward” arrow. Defined filters are displayed in the “Subsystem” list box as a 
scrolling list of option buttons on the directive builder window once OK is selected on the 
filter dialog box (e.g., AM1_AST for AM1 ASTER). 

Figure 6.2.5-2. Selection Filter Dialog Box 

3. Select filters. 

Click on one or more filter(s) to display the command mnemonics associated with the 
filter(s) from Subsystems list box. 

4. Display the submnemonics associated with a command mnemonic. 

Click a command mnemonic to display the submnemonics associated with the command in 
the “Selection Templates” list box. For example, if you select the 
AST_SET_S_PULSE_PARITY command, the submnemonics PARITY and PULSE 
as well as their maximum, minimum, and default values are displayed in the “Selection 
Templates” list box. 
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NOTE 

As you type a command mnemonic in the text box, the list scrolls to the first 
command matching your entry. 

5. Copy a command mnemonic to the ECL command line. 

Double-click a command mnemonic with the left mouse button to copy it to the ECL 
command line. Append a subdirective to the directive in the ECL command line by double 
clicking it with the left mouse button. Edit the directive by adding user-defined variables or 
other customization prior to inserting the directive into the procedure text. 

6.	 Insert the directive into the procedure and leave the Directive Builder 
window open. 

Click Apply to insert the directive at the current cursor location. 

or 

Insert the directive into the procedure and close the Directive Builder 
window . 

Click OK to insert the directive at the current cursor location and close the Directive Builder 
window. 

To insert a telemetry mnemonic into a procedure: 

A directive may include telemetry mnemonics in order to refer to its value in the directive. 

1.	 List all telemetry mnemonics. 

Click Tlms toggle button to list all telemetry mnemonics. 

2. Create filters for telemetry mnemonics. 

Click Filter to create spacecraft subsystem, or instrument, for telemetry mnemonics via 
the Selection Filter dialog box. Defined filters are displayed in the Subsystem window as a 
scrolling list of option buttons (e.g., AM1_AST for AM1 ASTER). 

3. 	 Select one or more filters. 

The telemetry mnemonics associated with the filter(s) are displayed. 

4. Select one of the mnemonics from the list. 

The limit sets or discrete values associated with that mnemonic are displayed in the 
“Selection Templates” list box in the Directive Builder window. Note that the box above 
the list of mnemonics may be used to find a mnemonic. As you type in the box, the list 
scrolls to the first mnemonic matching your entry. 

5. 	 Copy a mnemonic to the command line. 

Double-click a mnemonic with the left mouse button to copy it to the ECL command line. 
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6. Insert the directive into the procedure and leave the Directive Builder open. 

Click Apply to insert the directive into the procedure at the current cursor location. 

or 

Insert the directive into the procedure and close the Directive Builder. 

Click OK to insert the directive into the procedure at the current cursor location and close 
the Directive Builder window. 

6.2.6 View Procedure Meta Data 

Procedure Meta Data provides summary data concerning an open procedure. The meta data 
includes the name, type, latest syntax and validation status, location (path), authors username, the 
username of the individual who last modified the procedure, creation date, and last modified date. 
The procedure Meta Data is only updated when the procedure is saved, hence the Meta Data only 
reflects the saved changes. 

Select Meta Data... under the Tools menu of the Procedure Builder window to display the Meta 
Data dialog window for the open procedure (see Figure 6.2.6-1). Click Close to close the Meta 
Data dialog box. 

6.2.7 Exit the Procedure Builder 

To save a procedure before exiting, see section 6.2.1. Select Quit under the File menu to close the 
Procedure Builder window. 

Figure. 6.2.6-1. Meta Data Dialog Box 
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6.3 Execute a Procedure 

You can start a procedure from the Procedure Control, Control or Command Control window. 
The Procedure Control window enables you to closely monitor and exercise a greater degree of 
control over procedure execution than the Control or Command Control window. However, a 
procedures containing one or more spacecraft commands or ground directives may only be started 
from the Command Control window, 

6.3.1 Execute a Procedure from the Procedure Control Window 

On the Control window (see Figure 6.1.1-1), click Tools… to open the Tool Selection dialog 
box. Select Procedure Control from the list of tools or type the ECL TOOL directive, TOOL 
Procdure_Builder in the Control window command line. 

The Procedure Control window (see Figure 6.3.1-1) enables you to start a procedure, monitor and 
control its execution (refer to section 6.2.1 for the types of procedures). The status of each 
directive in the procedure is displayed and updated in the Procedure Control window as the 
procedure executes. 

1. Open a procedure. 

Select Open under the File menu of the Procedure Control window. The Open File dialog 
box opens. Select the file to be opened and click OK. 

2. Find text in a suspended or inactive procedure. 

Click Find to find text in the open procedure. The Find dialog box opens. Enter text to 
search for in the Find box and click OK. The Find dialog box closes and next directive 
containing the find text is highlighted. 

3. Start a procedure. 

Open a procedure by selecting Open from the File menu of the Procedure Control 
window. Click Resume to start the open procedure. 

4. Monitor execution of a procedure. 

The currently executing directive flashes in the Procedure Control window. The status 
column reads “active.” 

5. Designate directives to be skipped. 

Click Suspend to stop execution of the procedure. Set a jump point by placing the 
cursor on the last line containing a directive you want to skip and clicking Set Jump. 
The status column adjacent to the directives to be skipped changes to “Skip”. Resume 
execution of the procedure by clicking Resume. The directives up to and including the 
directive on the line where you set the jump point will be skipped. To remove a jump point, 
click Clear Jump. A procedure may contain only one jump point. 
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Figure 6.3.1-1. Procedure Control Window 

6. Override the WAIT directive. 

If the current directive is the WAIT directive, you can override the waiting period and 
execute the next directive immediately by clicking Go. 

7. Enter manual, non-command directives in the ECL command line. 

Only Local ECL directives, or ground directives (see section 6.1 for definition of local and 
ground directives), can be entered in the ECL command line while a procedure is active or 
inactive. Position the cursor on the line in the procedure text area where you wish to insert 
the directive. Enter the directive and press the <Return> key. 
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8. Suspend and resume execution of a procedure. 

While the procedure is executing, click Suspend . Once the active directive has 
executed, the procedure is suspended. Press the Resume button to continue execution of 
the procedure. 

9. Step through a procedure one directive at a time. 

While the procedure is executing, select Step at the top of the Procedure Control window. 
Execution of the procedure is suspended and the mode changes from Auto to Step. The 
next directive in the procedure to be executed flashes in the screen but will not execute until 
you click Step. While the procedure is in Step mode, you must click Step to start each 
successive directive in the procedure. To return to Auto mode, click the Auto toggle box. 
The next directive in the procedure automatically executes. 

10. Stop execution of a nested procedure and continue execution of the parent 
procedure. 

While a nested procedure (a procedure called by another procedure) is active, click 
Suspend . The nested procedure stops executing. To continue executing the parent 
procedure, click Return. The parent procedure will continue executing, commencing 
with the directive after the directive which called the nested procedure. 

11. Terminate execution of a procedure. 

Click Suspend to suspend the procedure. Click Kill to terminate the procedure. 

6.3.2 Execute a Procedure from the Control Window 

Local and Ground procedures can be executed from the Control Window, however ground 
procedures require ground authority (refer to Section 6.1.1). Enter the START directive in the 
ECL command line of the Control window (see Figure 6.1.1-1) followed by the procedure name, 
for example START proc name. The START directive is treated as a manual directive that must 
be confirmed prior to execution. The user directory is checked first for the procedure name entered 
in the START directive. If the procedure is not found, a search is performed in the system 
directory. The procedure is retrieved from the user or system directory and the procedure 
directives are executed in the background. The status of the procedure execution may be monitored 
through event messages on the Event Display window. 

The TIME directive may be appended to the START directive to delay the start of execution until a 
specified time, for example TIME=HH:MM:SS. 

6.3.3 Execute a Procedure from the Command Control Window 

Obtain command authority via the TAKE COMMAND directive (refer to Section 9 for additional 
information). On the Control window (see Figure 6.1.1-1), click Tools… to open the Tool 
Selection dialog box. Select Command Ground, Command and Emergency procedures can be 
executed from the Command Control Window Control from the list of tools or type the ECL 
TOOL directive in the Control window command line. 
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Enter the START directive in the CMD command line, for example START proc name. The 
START directive is treated as a manual directive that must be confirmed prior to execution. After 
the START directive is confirmed, it will be inserted into the command table section of the 
Command Control window along with any other ground script directives contained in the 
procedure. Each procedure directive executes as part of the ground script with appropriate status 
being posted in the Command Control window. A directive with the keyword time may be 
appended to the START directive to delay the start of execution until a specified time, for example 
TIME=YYYY/day HH:MM:SS. 

6.3.4 Procedure Arguments 

A procedure can accept optional arguments defined when the procedure is created (refer to 
Appendix A). Each argument is a specific type (integer, real, character). When the procedure is 
started, initial argument values are specified in the START directive: 

START ABC (1,2) 

Procedure ABC must begin with a prototype statement (see Appendix A, section A.1.2) which 
defines it as accepting two arguments, both integers as follows: 

PROC ABC (int $arg1, int $arg2) 

In this example, arg1 will be assigned the value 1 and arg2 will be assigned the value 2. The arg1 
and arg2 arguments are used in the same manner as variables within the procedure (i.e., their 
values may be referenced or updated). Refer to Appendix A for additional information concerning 
variables within procedures. 

6.4 Submit a Command Request to the Operations Controller 

The Command Request window (Figure 6.4-1) lists command requests submitted to the 
Operations Controller by members of the FOT or by ISTs connected to the EOC. Pressing the 
Create… button on the Command Request window opens the Command Request Creation 
window (Figure 6.4-2) which enables ISTs in the connected mode as well as FOT operators to 
submit requests for the Operations Controller to send command procedures, real-time commands 
or to activate a relative time command sequence. The Operations Controller’s review of command 
requests is discussed in Section 6.5. 

1. Open the Command Request window. 

Select Command_Request from the Tools menu of the Control or Mini-Control 
windows. 

2. Create a new command request or edit and existing request. 

To create a new command request, click on the Create… button on the Command Request 
window (Figure 6.4-1) to open the Command Request Creation window (Figure 6.4-2). 
On the Command Request Creation window, fill in the Subject and Instruction text 
fields. 

or 
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Figure 6.4-1. Command Request Window 

To edit an existing command request, select a command request on the Command Request 
window and click on the Create… button to open the Command Request Creation 
window. If desired edit the Subject and Instruction text fields. 

3. Add a procedure to the command request. 

At the time of this writing, adding a procedure to a command request via the Add Proc… 
button is not an available capability. This section of the document will be updated once the 
capability is made available. 

4. If desired, add a directive to the command request. 

Click on the Add Cmds… button on the Command Request Creation window to open the 
Directive Builder (Figure 6.4-3). Build an ECL directive by following the procedures 
described in paragraph 6.2 of this section. If desired, real-time commands may be included 
in through the Directive Builder. Once the directive is entered, click on the OK button to 
close the Directive Builder dialog and insert the directive into the table in the Command 
Request Creation window. 

5. Submit the command request to the Operations Controller. 

Click on the Submit button in the Command Request Creation window to submit the 
command request to the Operations Controller. The Command Request Creation window 
closes, revealing the Command Request window. Press the Refresh button to refresh the 
Status window and display the newly submitted command request and its status. Highlight 
the request’s status and click on the View… button to open the Command Request 
Evaluation window (Figure 6.4-4). If the command was rejected, click on the Reason 
button to display the explanation for the rejection in the Command Request Rejection dialog 
box (Figure 6.4-5). 
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Figure 6.4-2. Command Request Creation Window 

Figure 6.4-3. Directive Builder Window 
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Figure 6.4-4. Command Request Evaluation Window 
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Figure 6.4-5. Command Request Rejection Dialog Box 

6.	 Close the Command Request window. 

Click on the Close button. 

6.5 Evaluate a Command Request 

In order to evaluate command requests submitted by the ISTs and members of the FOT, you must 
be authorized to assume the Operations Controller role and must open the Command Request 
window in the Operations Controller role. 

1. Open the Command Request window. 

Select Command_Request from the Tools menu of the Control or Mini-Control 
windows. The Command Request window opens (Figure 6.5-1). 

2. Examine a submitted command request. 

Select the command request from the table and press the View… button to open the 
Command Request Evaluation window (Figure 6.5-2). 
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Figure 6.5-1. Command Request Window 

Figure 6.5-2. Command Request Evaluation Window 
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3. Accept the command request. 

Press the Accept button to accept the request. The Command Request Handler window 
opens, indicating notification was sent to the originator. 

Press the Merge button to merge the command request and close the Command Request 
Evaluation window. 

or 

Reject the command request. 

Press the Reject… button to reject the request. The Rejection dialog box opens (Figure 
6.5-3). Enter the reason(s) for the rejection and click OK to close the Rejection dialog 
box. Click the Cancel button to close the Command Request Evaluation window. 

4. Update the status displayed for the command request. 

Press the Refresh button to display the updated status for the command request in the 
status column of the Command Request window. 

5.	 Close the Command Request window. 

Click the Close button. 

Figure 6.5-3. Rejection Dialog Box 
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